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Safety Instructions
Safety Instructions • English

 WARNING:  This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within 
the product’s enclosure that may present a risk of electric shock.

ATTENTION:	  This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron website, 
www.extron.com.

   
 

  

 
 

 

Sicherheitsanweisungen • Deutsch

WARUNG:	 Dieses Symbol  auf demProdukt soll den Benutzer darauf 
aufmerksam machen, dass im Inneren des Gehäuses dieses Produktes 
gefährliche Spannungen herrschen, die nicht isoliert sind und die einen 
elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in 
der im Lieferumfang enthaltenen Dokumentation besonders wichtige 
Hinweise zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in den 
Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:		 Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de importantes instrucciones de 
uso y mantenimiento estas estan incluidas en la documentación 
proporcionada con el equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad de 
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT :	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du 
produit d’une tension électrique dangereuse susceptible de provoquer 
un choc électrique.

ATTENTION :	 Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec 
l’équipement.

Pour en savoir plus sur les règles de sécurité, la conformité à la réglementation, 
la compatibilité EMI/EMF, l’accessibilité, et autres sujets connexes, lisez les 
informations de sécurité et de conformité Extron, réf. 68‑290-01, sur le site 
Extron, www.extron.com.

Istruzioni di sicurezza • Italiano 

AVVERTENZA:	 Il simbolo, , se usato sul prodotto, serve ad avvertire 
l’utente della presenza di tensione non isolata pericolosa all’interno 
del contenitore del prodotto che può costituire un rischio di scosse 
elettriche.

ATTENTZIONE:	 Il simbolo, , se usato sul prodotto, serve ad avvertire 
l’utente della presenza di importanti istruzioni di funzionamento e 
manutenzione nella documentazione fornita con l’apparecchio.

Per informazioni su parametri di sicurezza, conformità alle normative, 
compatibilità EMI/EMF, accessibilità e argomenti simili, fare riferimento alla Guida 
alla conformità normativa e di sicurezza di Extron, cod. articolo 68‑290‑01, sul 
sito web di Extron, www.extron.com.

Instrukcje bezpieczeństwa • Polska 

OSTRZEŻENIE:	 Ten symbol, , gdy używany na produkt, ma na celu 
poinformować użytkownika o obecności izolowanego i niebezpiecznego 
napięcia wewnątrz obudowy produktu, który może stanowić zagrożenie 
porażenia prądem elektrycznym.

UWAGI:	 Ten symbol, , gdy używany na produkt, jest przeznaczony do 
ostrzegania użytkownika ważne operacyjne oraz instrukcje konserwacji 
(obsługi) w literaturze, wyposażone w sprzęt.

Informacji na temat wytycznych w sprawie bezpieczeństwa, regulacji wzajemnej 
zgodności, zgodność EMI/EMF, dostępności i Tematy pokrewne, zobacz Extron 
bezpieczeństwa i regulacyjnego zgodności przewodnik, część numer 68-290-01, 
na stronie internetowej Extron, www.extron.com.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ:	 Данный символ, , если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению 
электрическим током.

ВНИМАНИЕ: 	 Данный символ, , если указан на продукте, 
предупреждает пользователя о наличии важных инструкций по 
эксплуатации и обслуживанию в руководстве, прилагаемом к 
данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других вопросах 
см. руководство по безопасности и соблюдению нормативных 
требований Extron на сайте Extron: , www.extron.com,  
номер по каталогу - 68-290-01.

https://www.extron.com
https://www.extron.com
https://www.extron.com
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https://www.extron.com
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安全说明 • 简体中文 

警告： 产品上的这个标志意在警告用户, 该产品机壳内有暴露的危险
电压，有触电危险。

注意： 产品上的这个标志意在提示用户, 设备随附的用户手册中有重
要的操作和维护(维修)说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍使 
用的特性等相关内容， 
敬请访问 Extron 网站 , www.extron.com，参见 Extron 安全规范指南，产品编号 
68-290-01。

安全記事 • 繁體中文 

警告:  若產品上使用此符號，是為了提醒使用者，產品機殼內存在未隔離的危

險電壓，可能會導致觸電之風險。

注意	  若產品上使用此符號，是為了提醒使用者，設備隨附的用戶手冊中有重

要的操作和維護（維修）説明。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細資訊，

請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與法規遵守手

冊》，準則編號 68-290-01。

 

   

   

  
   

안전 지침 • 한국어 

경고: 	 이 기호  가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:	 이 기호  가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 대한 
자세한 내용은 Extron 웹 사이트(www.extron.com)의 Extron 안전 및 규제 준수 
안내서, 68-290-01 조항을 참조하십시오. 

Copyright
© 2021 Extron.  All rights reserved. www.extron.com

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.
The following registered trademarks (®), registered service marks (SM), and trademarks (TM) are the property of RGB Systems, Inc. or Extron (see 
the current list of trademarks on the Terms of Use page at www.extron.com):

Registered Trademarks (®)

Extron, Cable Cubby, ControlScript, CrossPoint, DTP, eBUS, EDID Manager, EDID Minder, eLink, Flat Field, FlexOS, Glitch Free, 
Global Configurator, Global Scripter, GlobalViewer, Hideaway, HyperLane, IP Intercom, IP Link, Key Minder, LinkLicense, LockIt, MediaLink, 
MediaPort, NAV, NetPA, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, ShareLink, Show Me, SoundField, SpeedMount, SpeedSwitch, 
StudioStation, System INTEGRATOR, TeamWork, TouchLink, V‑Lock, VideoLounge, VN‑Matrix, VoiceLift, WallVault, WindoWall, XPA, XTP, 
XTP Systems, and ZipClip

Registered Service Mark(SM) :  S3 Service Support Solutions

Trademarks (™)

AAP, AFL (Accu‑RATE Frame Lock), ADSP (Advanced Digital Sync Processing), AVEdge, CableCover, CDRS (Class D Ripple Suppression), 
Codec Connect, DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, 
DSVP (Digital Sync Validation Processing), EQIP, Everlast, FastBite, Flex55, FOX, FOXBOX, IP Intercom HelpDesk, MAAP, MicroDigital, 
Opti‑Torque, PendantConnect, ProDSP, QS‑FPC (QuickSwitch Front Panel Controller), Room Agent, Scope‑Trigger, SIS, Simple Instruction Set, 
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FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause interference. This interference must be corrected at the expense of the user.

NOTE:	 For more information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and Regulatory 
Compliance Guide on the Extron website.

Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

CAUTION:		  Risk of minor personal injury.

ATTENTION :	 Risque de blessure mineure.

ATTENTION:	

•	 Risk of property damage. 

•	 Risque de dommages matériels.

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,0p1 scene 1,1 ̂ B 51 ̂ W^C.0
[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]
E X! *X1&* X2)* X2%* X2# CE}

NOTE:	 For commands and examples of computer or device responses used in this 
guide, the character “0” is the number zero and “O” is the capital letter “o.” 

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
C:\Program Files\Extron

Variables are written in slanted form as shown here:

ping xxx.xxx.xxx.xxx —t
SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

http://www.extron.com/68-290-01
http://www.extron.com/68-290-01


Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

Extron Glossary of Terms
A glossary of terms is available at http://www.extron.com/technology/glossary.aspx.

http://www.extron.com
http://www.extron.com/technology/glossary.aspx
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Introduction

•	 About this Guide

•	 About the NAVigator

•	 Features

About this Guide
This guide contains installation, configuration, and operating information for the Extron 
NAVigator Pro AV over IP System Manager.

About the NAVigator
The NAVigator (see figure 1) manages, configures, and controls an AV streaming system 
consisting of Extron NAV encoders, and decoders (endpoints). The NAVigator also provides 
a centralized communication bridge between the control system and the endpoints. 
The NAVigator can support up to 16 endpoints as shipped and can be upgraded via 
LinkLicenses to support up to 48, 96, or 240 endpoints.

e
CONFIG

NAVigator

LAN

LNK

ACT

00 B NAV

NAVigator

OOB NAV/PoE

L
A

N

PC

NAV Encoder 1

NAV Encoder 2

NAV Encoder 3

NAV Encoder n

NAV Decoder 1

NAV Decoder 2

NAV Decoder 3

NAV Decoder n

AV
Streaming
Network

Control
Network

Figure 1.	 Typical NAVigator Application

The NAVigator provides one central web management interface. It expedites the 
system deployment process through bulk endpoint configuration, EDID Minder, and ties 
management features. In addition, it also makes system management easier through 
system tools such as firmware upgrade, backup, and restore.

The NAVigator is housed in a 1-inch high, half-rack width metal enclosure that can be 
mounted in any standard 19-inch rack or under furniture with optional mounting kits.

The NAVigator can be powered via Power over Ethernet (PoE) or by an included external 
100 VAC to 240 VAC, 50-60 Hz power supply that provides worldwide power compatibility.
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About the System
The NAVigator and NAV endpoints form an AV over IP switching matrix on an Internet Group 
Management Protocol (IGMP) Managed IP Network. The managed AV system can stream:

•	 HDCP 2.3-compliant HDMI video (which can include embedded digital audio) at 
resolutions up to 4k@60 Hz and 4:4:4 chroma sampling

•	 Optional analog audio

•	 RS-232 and IR control signals

NOTE:	 The RS-232 and IR communications are only controllable through an Extron 
Control Processor via a Secure Platform Device (SPD) (see the Global Configurator 
Plus Help File). The encoder and decoder do not generate or respond to the RS-232 
and IR communication signals.

The encoders are configured for low latency multicast streaming.

The decoders tie to an encoder.

Features
•	 Securely manages, configures, and controls NAV Pro AV over IP systems.

•	 Each unit supports up to 240 NAV endpoints — Offers encrypted management and 
control up to 240 NAV endpoints for centralized, secure management of complete Pro 
AV over IP systems.

•	 Intuitive, web-based user interface for ease of use — Intuitive graphical web 
interface for configuration, monitoring, backup/restoration, and troubleshooting.

•	 Manages simultaneous configuration of multiple NAV devices — Enables bulk 
configuration of a large number of devices in a single operation, saving time and 
simplifying setup.

•	 Secure encrypted communication between all endpoints — Features secure 
communication ensuring any data sent to encoders or decoders from the NAVigator is 
encrypted.

•	 Power over Ethernet, or PoE, eliminates the need for a local power supply — 
PoE enables receipt of power directly from the PoE switch, eliminating the need for 
bulky local power supplies.

•	 Scalable with LinkLicense — The base NAVigator system supports 16 devices with 
the capability to expand to 48, 96, or 240 with the addition of LinkLicenses. 

•	 Multiple NAVigator systems can work together to support thousands of endpoints, 
creating future-ready solutions that grow with your organization.

•	 Secure network isolation with dual LAN interfaces — Two isolated, independent 
LAN ports facilitate control from a secondary network, enabling flexible system design 
with enhanced security, and eliminating AV traffic on the corporate network.

•	 Enables parallel firmware update of multiple NAV devices at once — Upgrades 
firmware on all endpoints directly from the NAVigator web interface for quick and reliable 
firmware management that enables efficient system enhancements.

•	 Integrates with Pro Series control systems for secure, user-friendly external 
control — Designed to integrate directly with Extron Pro Series control systems for 
secure, encrypted RS‑232 and IR control of external devices without the need for 
additional control processors.
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•	 External Extron Everlast power supply included — Provides worldwide power 
compatibility with high‑demonstrated reliability and low power consumption.

•	 Extron Everlast Power Supply is covered by a 7‑year parts and labor warranty.

•	 1-inch (2.5 cm) high, half rack width metal enclosure — Compact, low profile 
enclosure for discreet placement and concealment.
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Installation and 
Operation

This section describes the installation and the operation of the NAVigator, including:

•	 Rear Panel Connections and Features

•	 Front Panel Connection and Indicators

•	 Basic Operation

NOTE:	 For equipment mounting, see Mounting the NAVigator on page 122.

Rear Panel Connections and Features
 

POWER
12V   
0.5 A MAX

NAVigator

RESET

OOB NAV/PoE

L
A

N

BBBCCCAAA DDD

Figure 2.	 NAVigator Rear Panel Connectors and Features

A	 Power connector (optional) — See below.

B	 NAV/PoE port — See page 5.

C	 OOB (Out of Band) port

D	 RESET button and LED

 

A	 Power connector (optional) — Plug the included external 12 VDC power supply into 
this 2-pole connector for power by a local device.

ATTENTION:

•	 Do not connect power to the NAVigator until you have read the CAUTION and 
ATTENTION notices on pages 6 and 7.

•	 Ne connectez pas l’alimentation à l’NAVigator avant d’avoir lu les rubriques 
« ATTENTION » des pages 6 et 7.

NOTE:	 Alternatively, the NAVigator can be powered via PoE, supplied by either an 
optional PI 140 Power Injector or a PoE capable network switch.
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B	 NAV/PoE port (see figure 2 on page 4)— Connect this port to your A/V LAN network 
for control of the NAVigator, control of the A/V streaming network (NAV encoders and 
decoders), or both. Optionally, you can also power the NAVigator by inserting PoE 
through this port. Streaming endpoints must be on the same network as the 
NAV/PoE port.

ATTENTION:

•	 Power over Ethernet (PoE) is intended for indoor use only. It is to be connected 
only to networks or circuits that are not routed to the outside plant or building.

•	 L’alimentation via Ethernet (PoE) est destinée à une utilisation en intérieur 
uniquement. Elle doit être connectée seulement à des réseaux ou des circuits 
qui ne sont pas routés au réseau ou au bâtiment extérieur.

 C	 OOB (Out of Band) port — Connect this port to a network for remote management of 
the NAV System. The OOB port cannot receive PoE.

NOTE:	 The OOB Port should not be connected to the same network as the 
NAV/PoE Port.

D	 RESET button and LED — Press this button and observe the LED to initiate three 
levels of NAVigator reset (see Reset Operations, on page 8).

Connector and Cable Details

Twisted pair cable termination and recommendations
Figure 3 details the TIA/EIA T568-B wiring standard. Use this standard to terminate twisted 
pair (TP) cables with RJ-45 connectors.

5

Pin

1

2

3

6

7

8

4

Side
12345678

Insert
Twisted

Pair Wires

Pins: RJ-45
Connector

Wire color

White-green

Green

White-orange

White-blue

Orange

White-brown

Brown

Blue

TIA/EIA T 568B

Figure 3.	 TP Cable Termination
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Power supply wiring
Figure 4 shows how to wire the connector. Use the supplied tie-wrap to strap the power 
cord to the extended tail of the connector.
 

Power Supply
Output Cord

Captive Screw
Connector

SECTION  A–A

RidgesSmooth

AA

Tie Wrap

3 5

Figure 4.	 Power Connector Wiring

CAUTION:

ATTENTION :
•	 The DC output cables must be kept separate from each other while the power 

supply is plugged in. Remove power before wiring.

•	 Les câbles de sortie CC doivent être séparés les uns des autres tant que la 
source d’alimentation est branchée. Coupez l’alimentation avant d’effectuer les 
raccordements.

•	 The length of exposed wires is critical. The ideal length is 3/16 inch (5 mm).

•	 Any longer and the exposed wires may touch, causing a short circuit.

•	 Any shorter and the wires can be easily pulled out even if tightly fastened by the 
captive screws.

•	 La longueur des câbles exposés est primordiale. La longueur idéale est de 5 mm 
(3/16 inches).

•	 S’ils sont un peu plus longs, les câbles exposés pourraient se toucher et 
provoquer un court circuit.

•	 S’ils sont un peu plus courts, ils pourraient sortir, même s’ils sont attachés par 
les vis captives.

•	 Do not tin the power supply leads before installing them in the connector. Tinned 
wires are not as secure in the connector and could be pulled out.

•	 Ne pas étamer les conducteurs avant de les insérer dans le connecteur. Les câbles 
étamés ne sont pas aussi bien fixés dans le connecteur et pourraient être retirés.

ATTENTION:
•	 This product is intended to be supplied by a UL Listed power source marked 

“Class 2” or “LPS,” rated 12 VDC, 1.5 A minimum. Always use a power supply 
supplied by or specified by Extron. Use of an unauthorized power supply voids all 
regulatory compliance certification and may cause damage to the supply and the 
end product.

•	 Ce produit est destiné à une utilisation avec une source d’alimentation listée UL avec 
l’appellation « Classe 2 » ou « LPS » et normée 12 Vcc, 1,5 A minimum. Utilisez 
toujours une source d’alimentation fournie ou recommandée par Extron. L’utilisation 
d’une source d’alimentation non autorisée annule toute conformité réglementaire et 
peut endommager la source d’alimentation ainsi que le produit final.
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ATTENTION:
•	 Unless otherwise stated, the AC/DC adapters are not suitable for use in air handling 

spaces or in wall cavities.

•	 Sauf mention contraire, les adaptateurs AC/DC ne sont pas appropriés pour une 
utilisation dans les espaces d’aération ou dans les cavités murales.

•	 The installation must always be in accordance with the applicable provisions of 
National Electrical Code ANSI/NFPA 70, article 725 and the Canadian Electrical 
Code part 1, section 16. The power supply shall not be permanently fixed to a 
building structure or similar structure.

•	 Cette installation doit toujours être en accord avec les mesures qui s’applique 
au National Electrical Code ANSI/NFPA 70, article 725, et au Canadian Electrical 
Code, partie 1, section 16. La source d’alimentation ne devra pas être fixée de 
façon permanente à une structure de bâtiment ou à une structure similaire.

•	 Power supply voltage polarity is critical. Incorrect voltage polarity can damage the 
power supply and the unit. The ridges on the side of the cord (see figure 4 on 
page 6) identify the power cord negative lead.

•	 La polarité de la source d’alimentation est primordiale. Une polarité incorrecte 
pourrait endommager la source d’alimentation et l’unité. Les stries sur le côté du 
cordon (voir l’illustration 4 sur la page 6) permettent de repérer le pôle négatif du 
cordon d’alimentation.

To verify the polarity before connection, plug in the power supply with no load and check the 
output with a voltmeter.

Front Panel Connection and Indicators

e
CONFIG

NAVigator

LAN

LNK

ACT

OOB NAV

BBBAAA CCC

Figure 5.	 NAVigator Front Panel Features

A	 Power LED — Indicates the unit power status.

Blinking — The unit is receiving power, either locally or remotely (via PoE) and is 
booting up.

Lit — The unit is receiving power, either locally or remotely (via PoE) and is operational.

B	 Configuration port — Connect to this USB mini-B port (USB 2.0) for product 
configuration, management and firmware updates.

C	 LAN LEDs (OOB and NAV) — Indicate the status of the ports.

Link (green) — Indicates the status of the link.

•	 Blinking — A network link has been established at 10/100 Mbps.

•	 Lit — A network link has been established at 1 Gbps.

Act (blinking amber) — Network activity is present. The blink rate corresponds to 
activity.
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Basic Operation

Configuration and Other Operations
Configuration and more complex operation of the system is accomplished via 
embedded web pages (see HTML Operation, beginning on page 10); Extron Toolbelt, 
Global Configurator Plus, Global Configurator Professional, or Global Scripter (see Control 
System on page 108), or SIS commands (see SIS Operation, starting on page 111).

Reset Operations
The rear panel RESET button initiates three modes of reset (numbered 1, 4, and 5, using 
standard Extron nomenclature; modes 2 and 3 are not applicable to NAV products). The 
RESET button is recessed, so use an Extron Tweeker, a pointed stylus, or ballpoint pen to 
access it.

See the table on page 9 for a summary of the modes.

ATTENTION:

•	 Review the reset modes carefully. Using the wrong reset mode may result in 
unintended loss of flash memory programming, port reassignment, or a controller 
reboot.

•	 Étudier de près les différents modes de réinitialisation. Appliquer le mauvais mode 
de réinitialisation peut causer une perte inattendue de la programmation de la 
mémoire flash, une reconfiguration des ports ou une réinitialisation du contrôleur.

NOTE:

•	 The reset modes listed in the table are separate functions, not a continuation from 
mode 1 to mode 5.

•	 The modes listed close all open IP connections and close all sockets.

•	 For reset modes 4 and 5, nothing happens if the momentary press does not occur 
within 1 second.
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Reset Mode Comparison and Summary

Mode Activation Result Purpose and 
Notes

1 Hold down the recessed RESET button while 
applying power to the unit.

NOTE:	 After a mode 1 reset is 
performed, update the unit firmware 
to the latest version. Do not operate 
the unit firmware version that results 
from the mode 1 reset. If you want to 
use the factory default firmware, you 
must upload that version again (see 
Updating the NAVigator firmware 
on page 74 for details on uploading 
firmware).

The unit reverts to the factory default firmware. All user files 
and settings, such as IP settings, are maintained.

NOTE:	 If you do not want to update firmware, or you 
performed a mode 1 reset by mistake, cycle power to 
the unit to return to the firmware version that was running 
before the mode 1 reset (see About Page on page 107 
to find the firmware version).

Use mode 1 
to return the 
unit to the 
factory default 
firmware version 
if incompatibility 
issues arise with 
user-loaded 
firmware.

H
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4 Hold the RESET button for approximately 
6 seconds, until the RESET LED blinks twice 
(once at 3 seconds and again at 6 seconds). 
Then momentarily press RESET within 1 
second.

Resets all the IP settings without affecting the device 
configuration.  Mode 4:

•	 Enables ARP capability.

•	 Sets the IP address, subnet address, gateway address, and 
port mapping to the factory default.

•	 Sets the Multicast IP, stream number and device name to the 
factory default.

•	 Turns DHCP on.

The RESET LED blinks three times in succession during the reset.

Mode 4 enables 
you to set 
IP address 
information using 
ARP and the 
MAC address.

R
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5 Hold the RESET button for approximately 
9 seconds, until the RESET LED blinks 
three times (once at 3 seconds, again at 6 
seconds, and then again at 9 seconds). Then 
momentarily press RESET within 1 second.

NOTE:	 Reset mode 5 reverts the 
factory-configured username to 
admin and password to extron.

Mode 5 performs a complete reset to factory defaults (with 
the exception of the firmware):

•	 Does everything mode 4 does.

•	 Resets most settings.

•	 Resets all IP options.

•	 Removes all files from the unit.

The RESET LED blinks four times in succession during the reset.

Mode 5 is for  
starting over with 
configuration 
and uploading 
or to replace 
events. Same as 
the EZQQQ} 
SIS command 
on page 115.

Fa
ct

o
ry

 r
es

et

Performing Mode 4 and 5 Resets
Perform resets of the unit as follows (see figure 6):

1.	 Use a small screwdriver to press and hold the rear panel RESET button until the rear 
panel RESET LED blinks either:

•	 Twice, for an IP settings reset

•	 Three times for an absolute (factory) reset

Release, then immediately
press and release again.

RESET

RESET

Release, then immediately
press and release again.

6 seconds

9 seconds

Press and hold 
the Reset button.

Press and hold 
the Reset button.

Reset LED blinks twice.

Reset LED blinks 
three times.

IP Settings 
Reset

Factory
Reset

(Mode 4)

(Mode 5)

Figure 6.	 Resets

2.	 Release the RESET button and then immediately press and release the RESET button 
again. Nothing happens if you do not momentarily press RESET within 1 second.
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HTML Operation

This section introduces using the built-in HTML pages to configure and operate the 
NAVigator, including:

•	 Opening the Embedded HTML Pages

•	 HTML Pages Overview

•	 Creating a NAV System

•	 Detailed Descriptions and Operations

The NAVigator can be controlled and operated through either the front panel CONFIG 
(USB) port (see figure 5, A on page 7) or the rear panel NAV/PoE port (see figure 2, B on 
page 4) or OOB port (C on page 5). The Configuration port uses IP over USB technology. 
The factory-embedded pages are always available and cannot be erased or overwritten.

NOTE:	 If connection to the NAVigator using either the NAV/PoE port or OOB port is 
unstable, try turning off the proxy server in your web browser.

Opening the Embedded HTML Pages
Access the NAVigator using HTML pages as follows:

1.	 Start the web browser.

NOTES:

•	 Extron recommends the following browsers to fully support the NAV system:

•	 Google Chrome™ — All screen images in this guide use Chrome.
•	 Mozilla Firefox™
•	 Microsoft® Edge™

•	 The network must be properly configured for multicasting (IGMP). Failure to do 
so may result in degraded performance.

2.	 Click in the Address field of the browser and enter the IP address.

NOTES:

•	 For the NAV/PoE+ port, if unit does not receive an IP address from the DHCP 
server, it self-assigns a Link Local IP address in the range 169.254.X.X.

•	 Default settings:

Port DHCP IP address Subnet mask
Config (USB)* 203.0.113.22

NAV/PoE (RJ-45) On

OOB (RJ-45) Off 192.168.253.254 255.255.255.0

*  For the Config port, the address for IP over USB CANNOT be changed.
  For the NAV/PoE port, if unit does not receive an IP address from the DHCP 

Server, it self-assigns a Link Local IP address in the range 169.254.X.X.

•	 If you use IP over USB, Extron recommends waiting a minute after plugging in 
the cable from your PC to identify the USB connection as a valid Ethernet port.
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3.	 Press the keyboard <Enter> key.

NOTES:

•	 If you do not have a trusted SSL Certificate, the browser displays a 
privacy notification (see figure 7). Continue to the login dialog box as follows:

1.	 Click the browser button that advances past the privacy notification (such as 
Advanced [1] in Chrome). Explanatory text and a link appear.

111111111111111111
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Figure 7.	 Privacy Notification (Shown in Chrome Browser)

2.	 Click Proceed to <IP address> (unsafe) (2) (or similar message).

•	 Your IT department can provide an uploadable SSL Certificate (see Toolbelt on 
page 108). Once the certificate is loaded, the notification does not occur.

The browser opens to the Login dialog box (see figure 8).
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Figure 8.	 Login Dialog Box

4.	 Enter the Username (see figure 8, 1) and Password (2) and click Sign In (3). The 
browser opens the embedded HTML page (see figure 9 on page 12).

NOTES:

•	 The factory configured passwords for all accounts on this device have been 
set to the device serial number. In the event of a complete system reset, the 
passwords revert to the default.

•	 The default username is admin and the default password is extron.

•	 Passwords are case sensitive.
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NOTES:	

•	 The HTML page may open with any of the panes (items 2 through 7 below) 
selected.

•	 The login automatically times out after 30 minutes of inactivity.
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Figure 9.	 Home Page

HTML Pages Overview
See figure 9 and the following sections for an overview of the following panes or functions. 
See Creating a NAV System on page 22 for procedures to use items 7, 2, and 3 to 
create a NAV system. See Detailed Descriptions and Operations on page 30 for detailed 
descriptions of items 4 through 7, and £.

1	 Menu icon — Toggles to hide or show the links pane (items 2 through 7).

2	 Endpoints link — Opens a page that allows you to discover and assign endpoints. You 
can then view these assigned endpoints and make configuration and communications 
settings changes to them (see Endpoints Page on page 13).

3	 Ties link — Opens a page that allows you to make and break ties. See Ties Page on 
page 14.

4	 EDID link — Opens a page that allows you to select an EDID and assign it to one or 
more inputs (encoders). See EDID Page on page 15.

5	 WindoWall link — Opens pages that allow you to configure NAV WindoWall canvases 
and to save, apply, and clear NAV WindoWall presets (see WindoWall Pages on page 16).

6	 Tools link — Opens pages that provide NAVigator tools and tools for entire system, 
including the endpoints (see Tools Pages on page 18).

7	 Monitoring link — Opens a page that shows system status information (see 
Monitoring Page on page 21).

8	 Settings link — Opens a page that provides access to many NAVigator device settings 
(see Settings Page on page 22).			 

9	 admin menu — Click to display the Sign Out button. Click Sign Out 
to log out of the NAVigator HTML pages.
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¢	 Name banner (see figure 9 on page 12) — Normally displays the host name. Resting 
the cursor over this banner changes the display from host name to the device name.

£	 About link — Opens a page that provides information about the NAVigator (see About 
Page on page 107).

Endpoints Page
The Endpoints page allows you to discover endpoints and assign one or more to the 
NAVigator. To access the Endpoints page, if necessary, click the Menu icon (see figure 10, 1 
and figure 11, 1). Click Endpoints (2). The Endpoints page opens. See Creating a NAV 
System on page 22 for a detailed description of discovering and assigning endpoints as 
part of creating a system.

Figure 10 shows the Endpoints page when no endpoints have been discovered or assigned.

Figure 11 shows the Endpoints page when endpoints have already been discovered and 
assigned and are online.

222222222222222222
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Figure 10.	 Endpoints Page with no Discovered Endpoints
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Figure 11.	 Endpoints Page with Discovered and Assigned Endpoints
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Ties Page
The Ties page allows you to make or break ties to create or change the input/output 
matrix in a NAV system. To access the Ties page, if necessary, click the Menu icon 
(see figure 12, 1). Click Ties (2). The Ties page opens, displaying a grid of endpoints 
assigned to this NAVigator and indicates existing ties. See Creating a NAV System on 
page 22 for a detailed description of assigning and tying endpoints as part of creating a 
system.
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111111111111111111

Figure 12.	 Ties Page
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EDID Page
The EDID page allows you to select an EDID and assign it to one or more inputs (encoders). 
To access the EDID page, if necessary, click the Menu icon (see figure 13, 1). Click EDID (2). 
The EDID page opens, displaying a library of available EDIDs, favorite EDIDs, and connected 
output (display) EDIDs. See EDID Page on page 52 for a detailed description of using 
EDIDs.

222222222222222222
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Figure 13.	 EDID Page



NAVigator System Manager • HTML Operation 16

 

WindoWall Pages
The NAVigator can support up to eight NAV WindoWalls with 	

222222222222222222
333333333333333333
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mixed sources. The NAVigator can support up to eight 
workspaces called canvases, each of which can support 
up to eight rows by eight columns.

The  WindoWall pages provide tools to configure canvases 
and to save, apply, and clear NAV WindoWall presets. To open the NAV WindoWall pages, if 
necessary, click the Menu icon (see figure 14, 1). Click WINDOWALL (see 1 in the illustration at 
right) and either Canvas Configuration (2) or Presets (3).

Canvas Configuration page
The Canvas Configuration page (see figure 14) provides tools to assign decoders to 
NAV WindoWall canvases. See WindoWall pages on page 62 for a detailed description of 
using this page and Creating presets on page 67 to create NAV WindoWalls and presets.
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Figure 14.	 Canvas Configuration Page

The Canvas Configuration page consists of the following elements:

2	 Canvas selection tabs — Select a canvas to configure.

3	 Canvas View — A grid diagram in which each cell represents a display in the 
NAV WindoWall and which can include the display number (displays are numbered 
horizontally on the canvas view), the decoder, and the total output resolution.

4	 Canvas Configuration — Provide the Canvas ID (for identification to a control system), 
define the size of the canvas, and assign it a name.
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5	 Output Assignments (see figure 14 on page 16) — Assign decoders to the displays 
in the NAV WindoWall.

6	 Display Settings — Adjust the display settings of all outputs in the canvas.

7	 Mullion Compensation (off-screen on figure 14, see figure 66 on page 66) — Adjust 
the space around displays to extend the image "behind" the bezels of flat panels.

Presets page
The Presets page (see figure 15) allows you to assign encoders (sources) to NAV WindoWall 
canvases and to save the canvas as a NAV WindoWall preset. See WindoWall pages on 
page 62 for a detailed description of using the Canvas Configuration page and this page 
and to create NAV WindoWalls and presets.
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Figure 15.	 WindoWall Presets Page

See figure 15. The Presets page consists of the following elements:

1	 Canvas selection tabs — Select a canvas to configure.

2	 Canvas view — A grid diagram in which each cell represents a display in the NAV 
WindoWall.

3	 Input and preset controls — Assign encoders, manage presets, and switch inputs.

TIP:	 Each canvas has a canvas ID (A) that identifies that canvas. If you need to 
reference a canvas from a control system, the canvas ID does not change, even if 
you have renamed the canvas.
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Tools Pages
The Tools pages provide tools for just the NAVigator (Device)	
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and tools for the entire system, including endpoints (System). 
To access the Tools pages, if necessary, click the Menu icon 
(see figure 16, 1). Click Tools (see 1 in the illustration at 
right) and select among:

•	 Device Tools (2, see "Device Tools page")

•	 System Tools (3, see System Tools page on page 19)

•	 Diagnostic Tools (4, see Diagnostic Tools page on page 20).

Device Tools page
The Device Tools page consists of four tabs (2), Backup, Restore, Firmware, and Reset 
that provide NAVigator tools. See Device Tools Page on page 71 for detailed descriptions 
of these NAVigator tools.
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Figure 16.	 Device Tools Page
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System Tools page
The System Tools page consists of three tabs (see figure 17, 1), Backup, Restore, and 
Firmware that provide tools for the NAV system, including all assigned endpoints. See 
System Tools Page on page 77 for a detailed description of these system tools.

111111111111111111

Figure 17.	 System Tools Page
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Diagnostic Tools page
The Diagnostic Tools page (see figure 18) provides tools that allow you to troubleshoot the 
connection to other units on the NAV network. Access the page as follows:

1.	 Click the Tools > Diagnostic Tools link on the left side of the browser (1). The 
browser displays the Diagnostic Tools page.
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Figure 18.	 Diagnostic Tools Page, Ping Results Shown

2.	 Click in the Address field and type in the IP address of another unit on the network (2).

3.	 Click either Ping or Trace (3), depending on the diagnostic you want to run.

NOTES:	

•	 Ping — Use this tool to test the connection to another unit on the network.

Figure 18, 4 shows the typical results of a Ping diagnostic.

•	 Trace — Use this tool to trace the network route taken by a packet from 
source to destination.

Figure 19 shows the typical results of a Trace diagnostic.

Figure 19.	 Trace Results Shown

5.	 Click Clear (5) to reset the Address field if you want to run another diagnostic.
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Monitoring Page
The Monitoring page shows system status information. To access the Monitoring page, 
click Monitoring (see figure 20, 1). The Monitoring page opens. See Monitoring Page on 
page 87 for a detailed description of the monitored functions.

111111111111111111

Figure 20.	 Monitoring Page
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Settings Page
The Settings page provides the ability to view and change NAVigator settings. To access 
the Settings page, click Settings (see figure 21, 1). The Device Settings page opens.

Using Network Connection (A) is described as part of the procedure to create a NAV system 
(see "Creating a NAV System," below).

Using all other selections (B) is described in Settings Page on page 93.
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Figure 21.	 Device Settings Page

Creating a NAV System
Connection to the NAVigator can be done via the embedded HTML pages. Creating a NAV 
system using the NAVigator and its embedded HTML pages is a six-part process:

1.	 Connect to the NAVigator via the embedded HTML pages (see Opening the 
Embedded HTML Pages on page 10).

2.	 View and change NAVigator network settings as necessary (see Network Connection 
Settings on page 23).

3.	 Discover and assign endpoints to the NAV system (see Discover and Assign 
Encoders and Decoders on page 25).

4.	 View and change endpoint network settings as necessary (see Configure Selected 
endpoint communication settings on page 27).

5.	 Configure the AV sources, displays, and other equipment. Once endpoint communication 
are established, validate input/output signals via the Device Details pane of the endpoints.

6.	 Create and validate ties between the endpoints (see Create Ties on page 29).

7.	 Construct a control system using either Global Configurator or Global Scripter (see 
Control System on page 108).
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Network Connection Settings
View and change connection settings as follows:

1.	 Obtain proper network connection values from the local system administrator.

2.	 If necessary, click the Menu icon (see figure 22, 1) to toggle the links pane (2) on.
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Figure 22.	 Network Connection Page

3.	 Click Settings (3). The Device Settings page opens.

4.	 Click Network Connections (4). The Network Connections drop-down menu opens, 
showing protected views of the network connection settings.



NAVigator System Manager • HTML Operation 24

 

5.	 Examine the network connection settings, comparing them against the values provided 
by the local system administrator. If all values are correct, proceed to Discover and 
Assign Encoders and Decoders on page 25.

6.	 To change the settings, click the appropriate (OOB - Public LAN or NAV - AV LAN) Edit 
button (see figure 23, 1). The Edit button changes to Save and the variable fields 
become available for editing.

NOTE:	 The IP Address, Subnet, Gateway, DNS Server, and DNS Suffix fields are 
unavailable for editing when DHCP is on.
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Figure 23.	 Device Settings Pane

7.	 If desired, click the DHCP switch (2) to toggle Dynamic Host Configuration Protocol on 
and off.

8.	 If desired, click the Port Enabled switch (3, OOB - Public LAN port only) to toggle the 
enable on and off.

9.	 If desired, click in the desired editable field (4) and edit it as desired.

10.	Repeat step 9 as necessary for other values.

11.	Click Save (1).

NOTE:	 If you change the settings of either port, you will lose communications 
momentarily while the NAVigator and endpoints self-reconfigure. This is normal.
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Discover and Assign Encoders and Decoders
Discover and assign encoders and decoders (endpoints) to the NAV system as follows:

1.	 If necessary, click the Menu icon (see figure 24, 1).
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Figure 24.	 Discover Endpoints

2.	 Click Endpoints (2).

3.	 Click Discover Endpoints (3). The Assign Endpoints page opens (see figure 26 on 
page 26).

NOTE:	 If you are adding to an existing set of assigned endpoints, at this point the 
endpoints page shows the existing endpoints and you click the Discover link 
instead (see figure 25, 1).

111111111111111111

Figure 25.	 Appearance of Endpoints Page when Adding to Existing 
Endpoints

Continue the discovery and assignment process as described in steps 4 and 5 on 
page 26.
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Figure 26.	 Assign Endpoints

NOTES:

•	 A banner advises you of how many endpoints you are using and how many for 
which you are licensed (see figure 26, A).

•	 The NAVigator, by default, is licensed for 16 endpoints.

•	 Additional endpoints, up to 240, are available via LinkLicense; contact the 
Extron S3 Sales and Technical Support Hotline (see www.extron.com for 
the phone number in your region of the world). See Loading a LinkLicense 
on page 101 to install the license.

•	 When you assign an endpoint to the NAVigator, the endpoint automatically 
assumes the password of the NAVigator.

TIPS:	

•	 Use the ID function to help identify an endpoint as follows: 

•	 Press and release the device ID button on the front panel of an endpoint 
to highlight the ID field on the HTML page for that endpoint (B). Press and 
release the button again to clear the highlight.

•	 Click the ID field (B) on the HTML page to toggle the front panel ID LED on 
the endpoint on and off.

•	 Tailor the list to more easily find specific endpoints as follows:

•	 Click the Filter drop-down menu (C) to show only endpoints by specific 
criteria (if created).

Click the Sort drop-down menu to arrange the order in which endpoints are 
displayed.

4.	 Click the All checkbox (1) or individual endpoint checkboxes (2).

5.	 Click Assign (3). The NAVigator assigns the	  
endpoints and reports success on the endpoints 
page.

NOTE:	 Once an endpoint is assigned, it can no longer be discovered by other 
NAVigators.

http://www.extron.com
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Configure Selected Endpoint Communication Settings

NOTE:	 This section configures selected endpoint settings using bulk configuration 
(the most convenient approach). See Endpoints page on page 30 for detailed 
descriptions of configuring all endpoint settings.

Configure selected endpoint settings in bulk (all at once) as follows:

1.	 If necessary, click the Menu icon (see figure 27, 1).
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Figure 27.	 Selecting Configure

2.	 If necessary, click Endpoints (2). The Endpoints page opens.

TIPS:	 Find specific endpoints more easily as follows:

•	 Use the ID button and Filter and Sort drop-down menus as described in the 
TIPS on page 26.

•	 Click in the Search field (A) and enter a few characters to show endpoints 
whose name or I/O number contain those characters.

3.	 Click the All checkbox (3) or individual endpoint checkboxes (4).

4.	 Click Actions (5) > Configure (6). The Configure Endpoints page opens (see 
figure 28 and figure 29, both on page 28).

5.	 Click the General link (see figure 28, 1) and the Network link (see figure 29, 1) as 
necessary to make the desired changes to the settings shown on the figures.

6.	 Click in one or more fields to be edited and make changes as necessary (see 
figure 28, 2 on figure 29, 2, both on page 28).

TIP:	 Open the HTML page of a single endpoint 
for configuration (see Device Details pane and 
proxy connections on page 49), as follows:

1.	 Click in the field for the connected endpoint (see 
figure 27, B). The HTML page opens a Device 
Details pane at the right of the page.

2.	 Click the IP Address (1, at right). The HTML 
page opens a new tab in the browser that is 
connected to the endpoint.  

111111111111111111
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Figure 28.	 Configure Endpoints > General
 

333333333333333333444444444444444444

222222222222222222

111111111111111111

Figure 29.	 Configure Endpoints > Network

3.	 Click Save (3) or Save All (4) on either figure).
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Create Ties
Create or change a tie in the NAV system as follows:

NOTE:	 You can also pair encoders and decoders to each other using the endpoint ID 
buttons (see the applicable endpoint guides available at www.extron.com).

1.	 If necessary, click the Menu icon (see figure 30, 1).

2.	 If necessary, click Ties (2). The page displays a grid of inputs and outputs.
 

444444444444444444

BBBBBBBBBBBBBBBBBB

AAAAAAAAAAAAAAAAAA222222222222222222

333333333333333333

111111111111111111

Figure 30.	 Create Ties

NOTE:	 The tabs (A) select the audio devices that are displayed in the grid. AES67 
audio must be enabled to be available (see Operation with AES67 Audio on 
page 126).

TIP:	 Use the browser zoom feature to see more devices in the ties grid.

3.	 Click to select the Set Tie Mode (Audio + Video, Audio Only, or Video Only (3).

4.	 Click within the grid of inputs and outputs to tie the desired input to the desired decoder 
(or all decoders) (4). Click in an existing tie to untie it.

TIP:	 Click in an All Decoders box (B) to tie an input to all outputs.

NOTE:	 In the figure 30 example, Audio + Video from input NAV-E-101-12-F2-41 is 
tied to All Decoders (all outputs).

5.	 If the Create Ties page asks you to confirm the change, click Continue.	
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Ties are displayed as follows:

Video and audio Video only Audio only

Detailed Descriptions and Operations

Endpoints Page
Besides the startup tasks of discovering and assigning endpoints to the NAVigator, 
the Endpoints pane has tools for “bulk” configuring one or multiple endpoints from the 
NAVigator. These tools are a more efficient way to manage your system than making 
changes to individual endpoints, either through their HTML pages directly (see the 
associated endpoint user guide) or proxied through the NAVigator (see Device Details 
pane and proxy connections on page 49).

Access the bulk configuration tools as follows:

1.	 If necessary, click the Menu icon (see figure 31, 1).
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Figure 31.	 Accessing Bulk Configuration Tools

TIPS:	 Find specific endpoints more easily as follows:

•	 Use the ID button and Filter (A) and Sort (B) drop-down menus as described 
in the TIPS on page 26.

•	 Click in the Search field (C) and enter a few characters to show endpoints 
whose name or I/O number contain those characters.

•	 Click Actions>Unassign (5>A) to unassign an endpoint from the NAVigator.

2.	 If necessary, click Endpoints (2). The Endpoints page opens.

3.	 Click the All checkbox (3) or individual endpoint checkboxes (4).

4.	 Click Actions (5) > Configure (6). The Configure Endpoints tools open (see figure 32 
on page 32).
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NOTE:	 The procedures that follow assume that you already have the General tab 
displayed on the Configure Endpoints tools (see the procedure on page 30).

The bulk configuration tools are located across several panes, accessible by the tabs 
identified in the following table. The table lists the panes, the functions available within them, 
and provides a link to detailed descriptions of changing those functions.

Tab Configurable function See:

General Name Add and edit names, tags, and locations 
on page 33

Input and output 
number

Edit input and output numbers on page 
35

Location Add and edit names, tags, and locations

Tags Add and edit names, tags, and locations

Network Communication 
Settings

Configure endpoint communication 
settings on page 37

Input HDCP authorized Configure input settings on page 38

Audio format Configure input settings

Output Video output Configure output video and audio 
settings on page 40

Allow audio only Configure output video and audio 
settings

HDCP mode Configure output HDCP settings on 
page 41

HDCP notification Configure output HDCP settings

Test pattern Output a test pattern on page 42

Scaling Decoder Output resolution Configure the scaler on page 43

Output rate Configure the scaler

Aspect ratio Configure the scaler

Auto memory Configure the scaler

Stream Bit rate (Mbps) Configure the streaming settings on 
page 44

Audio mode Configure the streaming settings

AES67 audio address Configure the streaming settings

USB (applicable 
endpoints only)

USB port settings Configure the USB settings on page 46

OSD On-screen display Configure the OSD on page 47

Screen saver Configure the screen saver on page 48

NOTES:

•	 When you make changes on a tab, two buttons become available:

•	 The Save button for that page (such as  for the General tab).

•	 The Save All button ( ).

•	 You can make changes on multiple panes and then save them all by clicking .

•	 You can sort each column by clicking the header row, for example  or .
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General tab
When the Configure Endpoints tools are opened, they open to the General page (see 
figure 32).

NOTE:	 The General procedures that follow assume that you already have the General 
tab displayed on the Configure Endpoints tools (see the procedure on page 30).

 

Figure 32.	 Endpoints Page, Configure Tools — General Tab
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Add and edit names, tags, and locations

You can add a tag to discovered endpoints that are part of a particular usage set. Tags 
simplify finding specific endpoints and managing ties. You can add tags to assigned 
endpoints, and rename endpoints as desired. You can also associate each endpoint to the 
location where it is installed.

TIP:	 As an example using these features, you can tag all of the encoders associated 
with one presenter and one location so that you can limit encoders to that user and 
room when making ties.

NOTE:	 See the NOTES on page 34 for detailed valid character usage rules to ensure 
your entries are valid.

Add and edit tags, names, and locations as follows:

1.	 If necessary, click and drag the horizontal scroll bar (see figure 33, 1) to the right to 
reveal the Location and Tags fields.

NOTE:	 The Name field is locked in position and does not move.
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Figure 33.	 Add and edit names, tags, and locations

2.	 To edit a Name or Location, click in the appropriate field and make changes as 
necessary (2).

NOTE:	 Name and Location can also be edited from the Settings > Device Settings 
page (see Editing device details on page 93).

3.	 Click anywhere outside the edited field.
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4.	 To create a tag for an individual assigned endpoint, click Add  (see figure 33, 3 
on page 33). An editable field opens (see figure 34).
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Figure 34.	 Creating a Tag

5.	 Click in the tag field and make changes as necessary (see figure 34, 1). When you click 
anywhere outside the tag field, the tag appears ( ).

6.	 To create a tag for all endpoints, click in the Edit All Tags field and make changes 
as necessary (see figure 33, 4 on page 33).

When you click anywhere outside the Edit All Tags field, 	  
the Add  and Remove  buttons appear (shown at right).

7.	 Click Add . The tag appears for each endpoint ( ).

NOTES:	

•	 Created tags cannot be edited.

•	 Delete a tag by clicking the .

•	 An endpoint can have a maximum of 10 tags.

8.	 Click anywhere outside the edited field or fields. The Save buttons become available. 

TIP:	 An asterisk (A) appears in the tab to indicate that there are unsaved changes.

9.	 Click Save General (5) or Save All (6) to save the changes or Cancel (7) to abandon 
them.

10.	Click X (8) to close the Configuration Endpoints page or select a different tab or 
perform other operations to change other settings.

See the following NOTES for the text rules that apply to tags, names, and locations.

NOTES:	

•	 Special characters, as used in the table below, are as follows: 
! ~ ` @ # $ % ^ & * ( ) _ + = { } [ ] |\ : ; “ ‘ < > , . ? and / . 
A hyphen (–) is not a special character.

•	 Tags, names, and locations each have a 63-character limit.

Tag Rules Name Rules Location Rules

•	 Cannot contain special 
characters.

•	 Cannot begin or end 
with a hyphen.

•	 Cannot begin with a 
space.

•	 Spaces are allowed 
after the first 
character.

•	 Multiple tags are 
allowed, making 
filtering and sorting 
searching easier.

•	 Must begin with a letter.

•	 Cannot contain special 
characters.

•	 Cannot end with a 
hyphen.

•	 Spaces are not allowed.

•	 Must begin with a letter.

•	 Cannot contain special 
characters.

•	 Cannot end with a 
hyphen.

•	 Hyphens are allowed 
in any other position.

•	 Cannot begin with a 
space.

•	 Spaces are allowed 
after the first character.
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Edit input and output numbers

By default, input and output numbers are assigned by the endpoints. Being generated by an 
algorithm, the numbers appear random. If desired, change them as follows:

1.	 Click in the desired Input or Output field (see figure 35, 1) and edit it as desired or click 
 or  to increment or decrement the field value. The valid range is from 1 to 4096.

NOTE:	 Each input requires a unique number and each output requires a unique 
number.

TIPS:

•	 Extron recommends sequential I/O numbering across the NAV system.

•	 If you sequentially number inputs and outputs, the NAV system function is 
similar to a traditional Extron matrix switcher.

 

222222222222222222 444444444444444444333333333333333333

555555555555555555

111111111111111111

AAAAAAAAAAAAAAAAAA

BBBBBBBBBBBBBBBBBB

A2

A3

A1

Figure 35.	 Edit input and output numbers

TIP:	 If you enter a value in either the Edit All Inputs or Edit All Outputs field 
(A), the first endpoint listed below the edited field is changed to that number ( A1). 
Subsequent input or output numbers (A2 and A3) increment as the endpoints are 
listed from top to bottom.
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2.	 Click anywhere outside the edited field or fields. The Save buttons become available.

TIP:	 An asterisk (B) appears in the tab to indicate that there are unsaved changes.

3.	 Click Save General (2) or Save All (3) to save the changes or Cancel (7) to abandon 
them.

4.	 Click X (see figure 35, 4 on page 35) to close the Configuration Endpoints page or 
select a different tab or perform other operations to change other settings.

Network tab

NOTE:	 The Network procedures that follow assume that you already have the General 
tab displayed on the Configure Endpoints tools (see the procedure on page 30).
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Figure 36.	 Endpoints Page, Configure Tools — Network Tab
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Configure endpoint communication settings

TIP:	 Adhere to IP addressing best practices and considerations for IP addressing 
schemes in a larger system.

1.	 Click the Network tab (see figure 36, 1 on page 36) to make changes to the network 
settings.

2.	 If desired, click either the Static or DHCP radio button to choose the desired IP 
addressing method.

•	 You can select either for all inputs (2) or one or more individual endpoints (3).

•	 You can select either radio button for all inputs (2) and then change the setting for 
individual endpoints (3).

•	 All of the other settings for an endpoint under this tab are unavailable for selection 
when that endpoint is selected for DHCP.

3.	 Click in one or more fields to be edited and make changes as necessary (4).

TIPS:

•	 If you enter a value in the Edit All IP Addresses field (A), the first endpoint 
listed below the edited field is changed to that number ( A1). 
The IP addresses for subsequent endpoints (A2 and A3) increment as the 
endpoints are listed from top to bottom unless you have also made a change 
to an individual endpoint (4).

•	 If you enter a value in either the Edit All Subnets, Edit All Gateways, or Edit 
All DNS field (B), all listed endpoints have that value unless you have also 
made a change to an individual endpoint (4).

4.	 Click anywhere outside the edited field or fields. The Save buttons become available.

TIP:	 After you make any change in steps 2 and 3, an asterisk (C) appears in the 
tab to indicate that there are unsaved changes.

5.	 Click Save Network (5) or Save All (6) to save the changes or Cancel (7) to abandon 
them.

6.	 Click X (8) to close the Configuration Endpoints page or select a different tab to 
change other settings.
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Input tab

NOTE:	 The Input procedures that follow assume that you already have the General tab 
displayed on the Configure Endpoints tools (see the procedure on page 30).
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Figure 37.	 Endpoints Page, Configure Tools — Input Tab

Configure input settings
1.	 Click the Input tab (see figure 37, 1) to make changes to the endpoint settings.

2.	 Click the Audio Format drop-down menu for all inputs (2) or for one or more individual 
endpoints (3) to select between Auto Detect, HDMI, or Analog.

3.	 If desired, select (click) or deselect the HDCP Authorized checkbox for all inputs (4) or 
for one or more individual endpoints (5).

NOTE:	 When HDCP Authorized is enabled (checked), the encoder informs the 
connected source that it can accept HDCP signals and is HDCP compliant. When 
disabled, the encoder informs the connected source that it is not HDCP compliant.

•	 For sources requiring encryption, enable HDCP Authorized. If HDCP Authorized 
is disabled for sources requiring encryption (for example, a Blu-ray player), the 
output is muted or a warning message is displayed.

•	 Some sources may encrypt their output even if the source material does not 
require HDCP encryption, preventing content from being displayed on a non-
HDCP compliant display. Disable HDCP Authorized to allow the output of the 
scaler to remain unencrypted.

TIP:	 After you make any change in steps 2 and 3, an asterisk (A) appears in the 
tab to indicate that there are unsaved changes.

4.	 Click Save Input (6) or Save All (7) to save the changes or Cancel (8) to abandon them.

5.	 Click X (9) to close the Configuration Endpoints page or select a different tab to 
change other settings.
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Output tab

NOTE:	 The Output procedures that follow assume that you already have the General 
tab displayed on the Configure Endpoints tools (see the procedure on page 30).

Figure 38.	 Endpoints Page, Configure Tools — Output Tab
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Configure output video and audio settings
Configure the video and audio output as follows:

1.	 Click the Output tab (see figure 39, 1).
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Figure 39.	 Configure Video and Audio Output Settings

2.	 Click the Video Output drop-down menu for all outputs (2)	  
or for one or more individual endpoints (3) to select among 
the available video output formats (shown at right). Auto (if 
selected) follows the input format.

NOTE:	 The decoders change their color space, chroma 
sampling and quantization parameters for compatibility 
with HDMI and DVI sink devices.

3.	 If desired, select (click) or deselect the Allow Audio Only 
checkbox for all outputs (4) or for one or more individual 
endpoints (5).

NOTE:	 When Allow Audio Only is enabled (checked), and 
if an active video input signal is not present in the stream, 
the decoder sends a black burst signal to the attached 
display. The black burst prevents the display from going 
into standby state, allowing the display speakers to play 
audio. When Allow Audio ONLY is disabled, the display 
goes into standby state if an active video input signal is 
not present regardless of whether active audio is.

TIP:	 After you make any change in steps 2 and 3, an 
asterisk (A) appears in the tab to indicate that there are 
unsaved changes.

4.	 Click Save Output (6) or Save All (7) to save the changes or Cancel (8) to abandon them.

5.	 Click X (9) to close the Configuration Endpoints page or select a different tab to 
change other settings.
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Configure output HDCP settings

Configure the output HDCP settings as follows:

1.	 Click the Output tab (see figure 40, 1).
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Figure 40.	 Configure Output HDCP Settings

2.	 If necessary, click and drag the horizontal scroll bar (2) to the right to reveal the HDCP 
fields.

NOTE:	 The Name field is locked in position and does not move.

3.	 Click the HDCP Mode drop-down menu for all outputs (3) or for one or more individual 
endpoints (4) to select between Follow Input and Always Encrypt.

NOTE:	 Follow Input mimics the HDCP encryption state of the connected source. 
Alway Encrypt maintains the HDCP encrypted state with the output sink device to 
improve system switching performance.

4.	 If desired, select (click) or deselect the HDCP Notification checkbox for all outputs (5) 
or for one or more individual endpoints (6).

NOTE:	 When HDCP Notification is enabled (checked) and the source video is 
HDCP encrypted but the display attached to the decoder is not HDCP compliant, 
the decoder outputs a green screen. When HDCP Notification is disabled, a the 
decoder does not output a green screen, but outputs a black screen instead.

TIP:	 After you make any change in steps 3 and 4, an asterisk (A) appears in the 
tab to indicate that there are unsaved changes.

5.	 Click Save Output (7) or Save All (8) to save the changes or Cancel (9) to abandon them.

6.	 Click X (¢) to close the Configuration Endpoints page or select a different tab to 
change other settings.
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Output a test pattern

Configure the output test pattern as follows:

1.	 Click the Output tab (see figure 41, 1).

555555555555555555 777777777777777777666666666666666666

888888888888888888

444444444444444444

333333333333333333

111111111111111111

222222222222222222

AAAAAAAAAAAAAAAAAA

Figure 41.	 Configure Test Pattern

2.	 If necessary, click and drag the horizontal scroll bar (2) to the right to reveal the Test 
Pattern drop-down menu.

NOTE:	 The Name field is locked in position and does not move.

3.	 Click the Test Pattern drop-down menu for all outputs (3) or for	  
one or more individual endpoints (4) to select among the available 
test patterns (shown at right) or no test pattern (Disabled).

NOTE:	 Test patterns are for debug and setup purposes. They 
let you validate a video signal path in the system and setup 
the displays connected to the outputs.

•	 Encoders can output color bar and grayscale test patterns.

•	 Decoders can output color bar, grayscale, alternating 
pixels, aspect crop lines, and crosshatch test patterns.

TIP:	 After you make a change in step 3, an asterisk (A) 
appears in the tab to indicate that there are unsaved changes.

4.	 Click Save Output (5) or Save All (6) to save the changes or Cancel (7) to abandon 
them.

5.	 Click X (8) to close the Configuration Endpoints page or select a different tab to 
change other settings.
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Scaling Decoder tab

NOTE:	 The Scaling procedures that follow assume that you already have the General 
tab displayed on the Configure Endpoints tools (see the procedure on page 30).

 

Configure the scaler 

Configure the output scaler settings as follows:

1.	 Click the Scaling Decoder tab (see figure 42, 1).
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Figure 42.	 Endpoints Page, Configure Tools — Scaling Decoder Tab

2.	 Click the Output Resolution drop-down menu for all outputs (2) or for one or more 
individual endpoints (3) to select among Follow Input (no scaling) or scaled to a 
desired output resolution from the options presented.

3.	 Click the Output Rate drop-down menu for all outputs (4) or for one or more individual 
endpoints (5) to select among the available rates.

NOTE:	 See the applicable decoder user guide, available at www.extron.com, for a 
detailed list of available output resolutions and rates.

4.	 Click the Aspect Ratio drop-down menu for all outputs (6) or for one or more individual 
endpoints (7) to select between Follow (no scaling, maintain the aspect ratio of the 
input video) or Fill (scale the output to fill the connected display).

5.	 If desired, select (click) or deselect the Auto Memory checkbox for all outputs (8) or 
for one or more individual endpoints (9). Auto memory automatically saves picture 
adjustments to memory based on the incoming signal resolution and recalls them when 
the resolution is detected.

TIP:	 After you make any changes in step 2 through 5, an asterisk (A) appears in 
the tab to indicate that there are unsaved changes.

6.	 Click Save Scaling Decoder (¢) or Save All (£) to save the changes or Cancel (¤) to 
abandon them.

http://www.extron.com
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7.	 Click X (¥) to close the Configuration Endpoints page or select a different tab to 
change other settings.

Stream tab

Configure the streaming settings

NOTE:	 Lay out the complete scheme for all streaming IP addressing before adjusting 
the addresses to avoid creating a situation in which the system becomes inoperable.

Configure the streaming settings as follows:

1.	 Click the Stream tab (see figure 43, 1).
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Figure 43.	 Endpoints Page, Configure Tools — Stream Tab

2.	 Click in the Bitrate field for all encoders (2) or for one or more individual encoders (3) 
and edit it as desired or click  or  to increment or decrement the field value. The 
valid range is from 150 to 9500.
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NOTE:	 The upper limit for 1G encoders is 900 Mbps. The upper limit for 10G 
encoders is 9500 Mbps. If you enter a Bitrate value for all encoders (2), it affects 
both 1G and 10G products.

3.	 Click the NAV Audio checkbox or all encoders (figure 43, 4 on page 44) or for one or 
more individual endpoints (5) to toggle NAV Audio on and off.

4.	 Click the AES67 checkbox for all encoders (6) or for one or more individual endpoints 
(7) to toggle AES67 audio on and off.

5.	 Click one or more IP address fields to be edited and make changes as necessary (8).

•	 AES67 Audio Address fields

•	 Video IP fields

•	 Audio IP fields

•	 USB IP fields (the field is present only for endpoints with USB streaming capabilities)

NOTES:

•	 Drag the scroll bar (A) as necessary to reveal fields on the right side of the 
screen. The right side of the Stream tab is revealed (see figure 44).

Figure 44.	 Revealed Fields

•	 The valid range for AES67 Audio Address fields is from 239.69.0.0 to 
239.69.255.255.

•	 The valid range for all other addresses on this pane is from 224.0.0.0 to 
239.255.255.255, exclusive of 239.69 addresses, which are reserved for AES67.

•	 Each field with an address must be unique.

TIPS:

•	 If you enter a value in the Edit All IPs field for a column of address (such 
as AES67 Audio Address (B), the first endpoint listed below the edited field is 
changed to that number (B1). Subsequent AES67 Audio Address numbers (B2 
and B3) increment as the endpoints are listed from top to bottom unless you 
have also made a change to an individual endpoint (8).

•	 After you make any changes in step 2 through 5, an asterisk (C) appears in the 
tab to indicate that there are unsaved changes.

6.	 Click anywhere outside the edited field or fields. The Save buttons become available.

7.	 Click Save Stream (9) or Save All (¢) to save the changes or Cancel (£) to abandon 
them.

8.	 Click X (¤) to close the Configuration Endpoints page or select a different tab to 
change other settings.
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USB tab

NOTE:	 The USB tab is present only if you select one or more endpoints with USB 
streaming capabilities in Configure Selected Endpoint Communication Settings, 
step 3 on page 27.

Configure the USB settings

Configure the USB streaming capabilities of applicable endpoints as follows:

1.	 Click the USB tab (see figure 45, 1).
 

999999999999999999 888888888888888888

555555555555555555

444444444444444444

333333333333333333

222222222222222222

555555555555555555333333333333333333

777777777777777777

666666666666666666

777777777777777777

111111111111111111
AAAAAAAAAAAAAAAAAA

¢¢¢¢¢¢¢¢¢¢¢¢¢¢¢¢¢¢

££££££££££££££££££

Figure 45.	 Endpoints Page, Configure Tools — USB Tab

2.	 Click the USB Port checkbox for all endpoints (see figure 45, 2) or for one or more 
individual endpoints (3) to toggle the port enabled and disabled.

3.	 Click the Mode drop-down menu for all endpoints (4) or for one or more individual 
endpoints (5) to select between Host and Device.

4.	 Click the Device Class Filtering drop-down menu for all inputs (6) or for one or 
more individual endpoints (7) to select between USB 2.0, or HID Only (Human Interface 
Device), a class of devices for human interface such as keyboards and mice.

NOTES:

•	 The Mode and Device Class Filtering drop-down menus are unavailable for 
selection if the USB port is disabled in step 2.

•	 Device Class Filtering restricts the USB device types, typically for security 
purposes. Different functionality applies in the two modes.



NAVigator System Manager • HTML Operation 47

 

TIP:	 After you make any changes in step 2 through 4, an asterisk appears in the 
tab to indicate that there are unsaved changes.

5.	 Click Save USB (see figure 45, 8 on page 46) or Save All (9) to save the changes or 
Cancel (¢) to abandon them.

6.	 Click X (£) to close the Configuration Endpoints page or select a different tab to 
change other settings.

OSD tab
Configure the On-screen display and screen saver capabilities of the endpoints as follows:

1.	 Click the OSD tab (see figure 46, 1).

2.	 For OSD settings, see "Configure the OSD," below.

For screen saver settings, see Configure the screen saver on page 48.

Configure the OSD
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Figure 46.	 Endpoints Page, Configure Tools — OSD Tab and Operations

3.	 Click the OSD Type drop-down menu for all endpoints (2) or for one or more individual 
endpoints (3) to select between Input OSD (input connection details), status OSD 
(general endpoint details), or Disabled (no OSD).

 

4.	 Click in the OSD Duration field for all endpoints (4) or for one or more individual 
endpoints (5) and edit it as desired or click  or  to increment or decrement the field 
value. The valid range is from 1 to 500 (in seconds) or 501 (always on).
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TIP:	 After you make any changes in step 2 and 3, an asterisk (A) appears in the 
tab to indicate that there are unsaved changes.

5.	 Click Save OSD (see figure 46, 6 on page 47) or Save All (7) to save the changes or 
Cancel (8) to abandon them.

6.	 Click X (9) to close the Configuration Endpoints page, select a different tab to change 
other settings, or continue to "Configure the screen saver".

Configure the screen saver
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Figure 47.	 Endpoints Page, Configure Tools — OSD Tab Screen Saver Operations

1.	 Click the Screen Saver Mute checkbox for all endpoints (figure 47, 1) or for one or 
more individual endpoints (2) to toggle the port enabled and disabled. This control sets 
whether a display immediately enters low power mode screen saver (is muted) upon 
loss of sync or displays selected screen (see Screen Saver Image, 5 or 6) for a period 
of time set by the Screen Saver Duration setting (3 or 4).

2.	 Click in the Screen Saver Duration field for all endpoints (3) or for one or more 
individual endpoints (4) and edit it as desired or click  or  to increment or 
decrement the field value. This control determines how long the screen saver stays 
active, before muting sync to a display. The valid range is from 1 to 500 (in seconds) or 
501 (always on). 

When Screen Saver Mute is unchecked, the duration automatically becomes 501.

After the duration expires, the encoder drops the active sync, allowing the display to 
turn off or enter low power mode.
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3.	 Click the Screen Saver Image setting drop-down menu for all endpoints (see 
figure 47, 5) or for one or more individual endpoints (6) to select among:

•	 Black Screen	 •	 Default Image (Extron) (Extron logo)
•	 Blue Screen	 •	 Custom Image (an image of your choosing)
•	 Retain Last Frame

NOTE:	 To be available for selection, the custom image must be manually uploaded 
into the endpoint (see the applicable User Guide at www.extron.com).

4.	 Click Save OSD (7) or Save All (8) to save the changes or Cancel (9) to abandon them.

5.	 Click X (¢) to close the Configuration Endpoints page or select a different tab to 
change other settings.

 

Device Details pane and proxy connections
A Device Details pane for an individual connected endpoint is available from the Ties page 
and from the Endpoints page that provides details about that endpoint.

To open the pane, click in the field for the connected endpoint on the Endpoints page (see 
figure 48, 1) or Ties page (2). The HTML page opens a Device Details pane to the right 
of the page (see figure 49 on page 50).
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Endpoints page

Ties page

Figure 48.	 Open an HTML Page for a Connected Endpoint
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Figure 49.	 Device Details Panes

TIPS:

•	 Tags, if created, are displayed on this pane (A).

•	 Click Break (B), if present (if this endpoint is part of a tie), to break the active 
tie.

Proxy connection

The HTML pages of an endpoint can be opened from the Device Details pane for 
additional configuration of that endpoint (known as “proxying an endpoint”).

Click the IP Address link in the Device Details pane (see figure 49, 1). The HTML page 
opens a new tab in the browser that is connected to the endpoint. The HTML page for 
the endpoint behaves as described in the user guides for the endpoint (see the applicable 
encoder and decoder guides available at www.extron.com).
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Ties Page
Creating ties using the Ties page tools is fully described in Create Ties on page 29.

You can also create ties using an Extron product that can be controlled by the Extron 
Digital Signal Processor (DSP) program, such as a DMP 128 Digital Matrix Processor (see 
Operation with AES67 Audio on page 126).
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Figure 50.	 Ties Pane Features

A	 NAV and AES67 (audio) Tabs — Select the desired tab to display only encoders 
streaming NAV audio, and only encoders streaming AES67 audio.

NOTE:	 AES67 audio must be enabled (see Operation with AES67 Audio).

B	 Filter menu (see figure 50) — Click the drop-down menu to show only endpoints by 
specific criteria (if created).

C	 Search Inputs field — Click in the field and enter a few characters to search for an 
input by name.

D	 Search Outputs field — Click in the field and enter a few characters to search for an 
output by name.

NOTE:	 See Add and edit names, tags, and locations on page 33 to assign and 
edit A, B, and C values.

E	 Break button — Unties any established ties when you click in a tie within the grid (F).

G	 Break All Ties button — Breaks all ties in the NAV system.
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TIP:	 You can also open the HTML page of a single 
endpoint for configuration (see Device Details pane 
and proxy connections on page 49), as follows:

1.	 Click in the field for the connected endpoint (see 
figure 50 H on page 51). The HTML page opens a 
Device Details pane at the right of the Ties page.

2.	 Click the IP Address (1, at right). The HTML page 
opens a new tab in the browser that is connected to 
the endpoint.  

111111111111111111

EDID Page
The EDID page (see figure 51) has several tools to tailor the grid to more easily find specific 
EDIDs.
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Figure 51.	 EDID Tools

A	 Search EDIDs — Enter a few characters in a resolution (such as "204" or "216" for 
2048 x 2160) or refresh rate (such as such as "6" for 60Hz) to search for EDIDs of only 
that resolution or rate.

B	 Available EDIDs — Click to show all EDIDs.

C	 Favorites — Click show only the EDIDs that you have designated as a favorite (see E 
and F on page 53).

D	 Connected Outputs — Click to display only the EDIDs of connected output displays 
(loop-through for the encoder and output for the decoder).
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NOTES:

•	 Available EDIDs — All EDIDs on the NAVigator including custom or uploaded 
EDIDs

•	 Favorite EDIDs — EDIDs that you have tagged as favorite (F).

•	 Connected Outputs — Sink devices connected on either the Encoder HDMI 
Loop through or the Decoder HDMI output.

E	 Set Favorite  icon (see figure 51 on page 52)— The EDID is not designated as a 
favorite. Click the icon in an EDID to toggle the favorite status of that EDID on.

F	 Favorite  icon — The EDID is designated as a favorite. Click the icon in an EDID to 
toggle the favorite status of that EDID off.
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Assign an EDID to an input
Use the EDID page to select an EDID and assign it to one or more inputs (encoders) as 
follows:

1.	 If necessary, click the Menu icon (see figure 52, 1). 
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Figure 52.	 EDID Pane

2.	 If necessary, click EDID (2). The EDID page displays a library of EDID files which you can 
select and then assign to one or more inputs (encoders).

 

3.	 Select the desired EDID (click the , 3). The selected EDID displays in the EDID field 
(see figure 53, 1 on page 55). Available input sources are also displayed (2).
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Figure 53.	 EDID Page With EDID Selected

4.	 Select one or more desired Input Sources (click the , see figure 54, 3). The selected 
sources display in the Input Sources field (see figure 53, 1).

NOTE:	 Click Select All  (see figure 54, A) to select all inputs with one click.
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Figure 54.	 EDID Page with Input Sources Selected

TIPS:	

•	 Click the EDID  (A) to clear all selections. The page appears as in figure 52 
on page 54.

•	 Click a selected Input Source  (B) to remove that input selection.

•	 Click Remove All  (C) to remove all input selections. The page appears as in 
figure 54.

5.	 Click Assign EDID (see figure 54, 2).	  
The NAVigator assigns the EDIDs and reports 
success on the EDID page.
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Download an EDID
Use the EDID page to download EDID from the library to your PC as follows:

1.	 If necessary, click the Menu icon (see figure 55, 1). 
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Figure 55.	 EDID Pane — Download an EDID

2.	 If necessary, click EDID (2).

For the EDID to download, click the Information ( ) icon (3).

The HTML page opens an EDID Summary pane to the right of the EDID page (4). The 
panel lists:

•	 Product name •	 Manufacturer ID •	 Video format

•	 Audio type •	 Native resolution •	 Maximum resolution

•	 Max. pixel clock •	 Maximum character rate •	 Colorspace and sampling

•	 Color bit depth •	 High Dynamic Range (HDR) •	 3D

3.	 Click Download EDID (5). Figure 55 shows the results of downloaded EDID in the 
Chrome browser (6).
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Add a custom EDID
Use the EDID page to add a custom EDID from your PC to the library as follows:

1.	 If necessary, click the Menu icon (see figure 56, 1). 
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Figure 56.	 EDID Page — Add a Custom EDID

2.	 If necessary, click EDID (2).

3.	 Click Add Custom EDID to Library (3). An Open dialog box opens (see figure 57 on 
page 58).
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Figure 57.	 Open Dialog Box

4.	 Navigate to the folder where the EDID file is saved (see figure 57, 1). Select the file.

5.	 Click Open (2). The NAVigator reports that it is	  
Uploading and then Adding the EDID to the library.

NOTE:	 This action happens quickly; you may not 
see it.

The EDID page returns to the top. The added EDID is displayed with a lighter border 
color (see figure 58, 1).
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Figure 58.	 Custom EDID Displayed in EDID Page
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Delete a custom EDID
Use the EDID page to remove a custom EDID as follows:

1.	 If necessary, click the Menu icon (see figure 59, 1). 
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Figure 59.	 Deleting a Custom EDID

2.	 If necessary, click EDID (2). The EDID page displays a library of EDID files.
 

3.	 Click the Information ( ) icon (3) on the custom EDID you want to remove. The HTML 
page opens an EDID Summary pane to the right (4).

NOTE:	 Factory-installed EDIDs cannot be removed.

TIP:	 Custom EDIDs are displayed with a lighter border color.

4.	 Click Remove EDID (5).The HTML page asks you	  
to confirm the deletion.

5.	 Click Remove. The NAVigator deletes the EDID	  
and reports success on the endpoints page.
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Find EDID common timings
The find EDID common timings function helps avoid a source device attached to a NAV 
encoder from sending a resolution and refresh rate that is beyond the capabilities of some 
displays in the system. Such an error would result in a black screen on displays whose 
performance capabilities have been exceeded.

Use the EDID page to find common timings as follows:

1.	 If necessary, click the Menu icon (see figure 60, 1). 
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Figure 60.	 EDID Pane and Common Timings

2.	 If necessary, click EDID (2). The EDID page displays a library of EDID files.
 

3.	 Click Connected Outputs (3). If two or more connected outputs are detected, the Find 
Common Timings button appears (4).

4.	 Click Find Common Timings (4). The page shows a list of connected outputs and timings 
that are common to them (see figure 62 on page 61). The page also recommends the 
highest resolution and refresh rate compatible with all selected displays (3).
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NOTES:

•	 EDIDs from Extron products are indicated in blue (see figure 61, A).
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Figure 61.	 EDID Banners

•	 EDIDs from the products of other companies are indicated in gray (B).

•	 The pale blue numbers (C) indicate the endpoint from which the connected 
output EDID (Display EDID) came.

•	 An encoder has (Loop-Thru) (D) in the EDID banner and the number in the 
pale blue background (C) is the input number.

•	 A decoder has (Output) (E) in the EDID banner and the number in the pale 
blue background (C) is the output number.
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Figure 62.	 Selecting the Common Timing

5.	 Click the checkbox to select all Connected Outputs (see figure 62, 1) or use the 
individual checkboxes (2) to select one or more connected outputs. 

6.	 Select the recommended Common Timing (3) or another available common timing (4).

7.	 Click Show EDIDs (5). Only the available EDIDs that match the resolution and refresh rate 
of the Common Timing selection appear (see figure 63 on page 62).
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Figure 63.	 Display of Common Timings

8.	 Assign the desired EDID to one of more encoders (see Assign an EDID to an input, 
beginning at step 3 on page 54).

TIP:	 Click Clear Common Timings (A) to clear the list.

WindoWall Pages
Creating a video wall is a multi-step process consisting of the following procedures:

NOTE:	 The list below presents a logical flow of operations; many of these operations 
can be performed in any order.

•	 Create a canvas (see "Creating a canvas," below).

•	 Configure all decoders in the canvas (see Configuring decoders on page 64).

•	 Configure the mullion, the space around each display within the canvas (see 
Configuring the mullion on page 66).

•	 Create presets (see Creating presets on page 67). A preset can recall different canvas 
layouts. Once the layout is recalled, you can switch inputs to change input on certain 
windows in the layout. This function is so that you needn't use presets just to change 
inputs.

•	 Recall a preset (make the matrix of inputs and outputs take effect (see Recalling 
presets on page 69).

Creating a canvas
Create a matrix of displays and assign decoders as follows:

1.	 If necessary, click the Menu icon ( , see figure 14, 1 on page 16).

2.	 If necessary, click WINDOWALL > Canvas Configuration	
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(see 1 > 2 in the illustration at right). The Canvas 
Configuration page opens (see figure 64 on page 63).

3.	 Click the appropriate Canvas tab to select the canvas to 
configure (see figure 64, 1).
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Figure 64.	 Canvas Configuration

4.	 Configure the size of the canvas (the number and arrangement of the displays) by 
clicking in the Columns and Rows fields (see figure 64, 2) and editing them as desired (or 
click  or  to increment or decrement the field value). The valid range for both fields 
is from 1 to 8. The canvas view (3) shows the arrangement of the displays. The Save 
button (7) becomes available.

NOTE:	 In the canvas view:

•	  = indicates that a decoder has been assigned to a display.
•	  = indicates that no decoder is assigned to the display.

TIP:	 An asterisk (A) appears in the Canvas tab to indicate that there are unsaved 
changes.

5.	 In the Output Assignment area (4), click the Display ID drop-down menu (5))	  
for one or more desired decoders to assign that decoder to the desired display 
within the canvas view.  changes to  for that display in the canvas view.

TIPS:

•	 If necessary, click and drag the left scroll bar (B) to display additional decoders.

•	 Click the blank space in the Display ID menu to unassign the decoder.

•	 Use the ID function to help identify a decoder to easily identify the display and 
verify that the right decoder is selected, as follows: 

•	 Press and release the device ID button on the front panel of a decoder to 
highlight the ID field in the Output Assignment area (C). Press and release 
the button again to clear the highlight.

•	 Click the ID button or ID All button (C) in the Output Assignment area to 
toggle the front panel ID LED and the on-screen display Status Screen for 
an individual decoder or all decoders on and off.
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6.	 If desired, highlight the Canvas Name field (see figure 64, 6 on page 63) and enter a 
custom name for the canvas.

NOTE:	 The name shown on the Canvas tab (1) changes as you type in characters, 
but the change does not take affect until you save the changes in step 7.

7.	 Click Save (7) to save all changes or Cancel (8) to abandon them.

Configuring decoders
Configure all decoders in a canvas at once, so that they have the same settings, as follows:

1.	 If necessary, click the Menu icon ( , see figure 14, 1 on page 16).

2.	 If necessary, click WINDOWALL > Canvas Configuration	
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(see 1 > 2 in the illustration at right). The Canvas 
Configuration page opens (see figure 65).
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Figure 65.	 Configuring Decoders

3.	 Click the appropriate Canvas tab to select the canvas to configure (see figure 65, 1).

4.	 If necessary, click and drag the right scroll bar (2) to reveal the Display Settings 
adjustments (3).

5.	 Make the following decoder adjustments, as necessary:

NOTE:	 After any change, an asterisk (see figure 65, A) appears in the Canvas tab to 
indicate the unsaved changes.

a.	 Click the Resolution drop-down menu (4) to select among the resolutions 
presented to scale all outputs in the canvas to the desired output resolution.

b.	 Click the Refresh Rate drop-down menu (5) to select among the available rates for 
all outputs in the canvas.
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NOTES:

•	 See the applicable decoder user guide, available at www.extron.com, for 
a detailed list of available output resolutions and rates.

•	 The Total Resolution (see figure 65, B on page 64) displays the 
resolution of the entire canvas and changes as you make changes on the 
Resolution drop-down menu.

c.	 Click the Video Output Format drop-down menu (6) to select among the available 
video output formats for all outputs in the canvas. Auto (if selected) follows the input 
format.

NOTE:	 The decoders change their color space, chroma sampling and 
quantization parameters for compatibility with HDMI and DVI sink devices.

d.	 Click the Color Bit Depth drop-down menu (7) to force all outputs in the canvas 
to 8-bit depth or Auto. Auto (if selected) communicates with the sink display to see 
check its capabilities and sets the color bit depth accordingly.

e.	 Click the HDCP Mode drop-down menu (8) to select between Follow Input and 
Always Encrypt for all outputs in the canvas.

NOTE: Follow Input mimics the HDCP encryption state of the connected 
source. Alway Encrypt maintains the HDCP encrypted state with the output 
sink device to improve system switching performance.

f.	 Click the Aspect Ratio drop-down menu (9) to select between Follow (no scaling, 
maintain the aspect ratio of the input video) or Fill (scale the output to fill the 
connected display) for all outputs in the canvas.

6.	  Click Save (¢) to save all changes or Cancel (£) to abandon them.

http://www.extron.com
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Configuring the mullion
Configure all decoders in a canvas at once, so that they have the same settings, as follows:

1.	 If necessary, click the Menu icon ( , see figure 14, 1 on	
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page 12).

2.	 If necessary, click WINDOWALL > Canvas Configuration 
(see 1 > 2 in the illustration at right). The Canvas 
Configuration page opens (see figure 66).
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Figure 66.	 Configuring Mullions

3.	 Click the appropriate Canvas tab to select the canvas to configure (see figure 66, 1).

4.	 If necessary, click and drag the right scroll bar (2) to reveal the Mullion Compensation 
adjustments (3).

5.	 Make the following mullion adjustments, as necessary:

NOTE:	 After any change, an asterisk (see figure 66, A) appears in the Canvas tab to 
indicate the unsaved changes.

a.	 Click the Mullion Unit drop-down menu (4) to select among in (inches), mm, or 
pixels as the measurement unit used for the horizontal and vertical mullions (5 
and 6).

b.	 Click in the Horizontal Mullion field (5) and enter a numeric value of the width of 
the side bezels of the displays used on your NAV WindoWall.

c.	 Click in the Vertical Mullion field (6) and enter a numeric value of the width of the 
top and bottom bezels of the displays used on your NAV WindoWall.

NOTES:

•	 In these fields, mullions are detailed to the 2nd decimal point (n.nn) for 
inches and mm and whole numbers only for pixels.

•	 If H = V (8) is checked, Horizontal Mullion and Vertical Mullion are 
locked to each other; a change in one changes the other to the same 
value.

•	 Changes made in the Horizontal Mullion and Vertical Mullion fields are 
graphically represented in the canvas view (B).
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d.	 Click in the Display Diagonal field (see figure 66, 7 on page 66) and enter the 
diagonal dimension of the displays used in your NAV WindoWall.

NOTES:

•	 The Display Diagonal is always expressed in inches.

•	 The Display Diagonal is unavailable if Pixels is selected in the Mullion 
Unit field (4).

e.	 Click the H = V checkbox (8) to toggle the Horizontal Mullion and Vertical 
Mullion fields lock on and off. When checked the two fields are to each other; a 
change in one changes the other to the same value.

6.	 Click Save (9) to save all changes or Cancel (¢) to abandon them.

Creating presets
Once you have created and configured a canvas, you may find it helpful to create presets to 
allow you to quickly recall a specific canvas and associated encoders. Create one or more  
NAV WindoWall presets (up to eight presets per canvas) as follows:

NOTE:	 This procedure assumes that you have created a canvas (see Creating a 
canvas on page 62).

1.	 If necessary, click the Menu icon ( , see figure 14, 1 on page 16).

2.	 If necessary, click WINDOWALL > Presets. The Presets 	
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page opens (see figure 67 on page 68).

3.	 Click the appropriate Canvas tab to select the canvas for 
which to create a preset (see figure 67, 1).

4.	 If necessary, select (click) the Inputs tab (2).

5.	 If necessary, select (click) the Create Window radio button (3).

6.	 Drag and drop one or more encoders to the desired cells in the canvas view (4).

NOTES:

•	 Once you have dragged-and-dropped, you can resize the windows in the 
canvas view. Click the input you just placed in 	  
the canvas view. The canvas view window now 
has a thick black border. Use the cursor to 
move it over to the desired size. and click again 
to keep that size.

•	 If you click Apply (A), you switch all outputs in the canvas to the layout you 
have prepared without creating a preset. You cannot recall an applied 
WindoWall.

7.	 Click Save as Preset (5). The Save Preset pane opens (see figure 68 on page 68).

8.	 Select a preset number (see figure 68, 1).

NOTE:	 If you select a preset that is already used, that preset will be overridden.

9.	 Enter a preset name (2).

10.	Click Save (3) to save the preset or Cancel (4) to abandon the preset.

11.	Click X (5) to close the Save Preset pane.
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Figure 67.	 Creating a Preset
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Figure 68.	 Saving a Preset
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Recalling presets
Once you have created a preset, you need to recall it in order for it to take affect (making all 
of the preset ties). Recall a preset as follows:

1.	 On the WindoWall > Presets page, click the Presets tab (see figure 69, 1).
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Figure 69.	 Recalling a Preset

2.	 Click the desired Preset (2).

NOTE:	 The selected preset includes tools (A and B) for renaming, editing, and 
deleting presets (see below).

3.	 Click Recall (3) to recall the preset or Close Preview (4) to abandon the recall.

Renaming a preset

1.	 Click the pencil icon (see figure 69, A). 

2.	 Type the new name in the Name field	
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(see 1 at right).

3.	 Click the Check icon (2) to save the name or X 
(3) to abandon it.

Editing a preset

1.	 Click the Menu icon (1, at right) > Edit (2). The window returns to a	
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display similar to figure 68 on page 68.

2.	 Perform Creating presets on page 67.

Deleting a preset

1.	 Click the Menu icon (1, at right) > Delete (2). The window prompts 	
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you to confirm that you want to delete the preset.

2.	 Click  to confirm or  to abandon the deletion.
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Switching preset inputs
You can also switch inputs to the NAV WindoWall from the Presets page, as follows:

1.	 If necessary, click the Menu icon ( , see figure 14, 1 on page 16).

2.	 If necessary, click WINDOWALL > Presets. The Presets 	
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3.	 Recall a preset (see Recalling presets on page 69).

4.	 Click Switch Inputs (see figure 70, 1).

5.	 Drag and drop one or more encoders to the desired cells in the canvas display (2).
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Figure 70.	 Switching Preset Inputs

TIPS:	

•	 You can use a control system to recall a preset, and then you can switch inputs 
via the control system as well.

•	 The switch happens immediately as you drop the dragged input (release the 
mouse button).
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Tools Pages
The two Tools pages, Device Tools (tools for just the NAVigator) and System Tools (tools for 
the NAVIgator and all assigned endpoints) provide the following functions:

•	 Backup — You can make backup files for just the NAVigator itself (see "Backing 
up the NAVigator," below) or for the entire NAV system (including one or more or 
selected endpoints) (see Backing up the system on page 77). Backup files contain 
configuration settings and communications settings for all devices included in a backup.

•	 Restore — You can restore the configuration settings, communications settings or 
both, to their condition when the backup file was created for just the NAVigator (see 
Restoring the NAVigator on page 72) or to the NAV system (including one or more or 
selected endpoints) (see Restoring the system configuration on page 78).

•	 Firmware — From time to time, firmware updates will be made available on the 
Extron website. You can upgrade firmware for just the NAVigator (see Upgrading the 
NAVigator firmware on page 74 or firmware for NAV system (including one or more or 
selected endpoints) (see Upgrading the system firmware on page 83).

•	 Reset (Device Tools only) — You can reset or reboot the NAVigator (see Resetting the 
NAVigator on page 76).

Device tools page

Backing up the NAVigator

Backup the NAVigator settings as follows:

1.	 If necessary, click the Menu icon (see figure 71, 1).
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Figure 71.	 Opening the Device Backup Page

2.	 If necessary, click Tools > Device Tools (2). The Device Tools page opens.

3.	 If necessary, click Backup (3).
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4.	 Click Download Backup (see	  
figure 71, 4 on page 71).

The NAVigator creates a file of 
current settings and, depending on your browser, may prompt you to confirm that you 
want to save it.

NOTE:	 Unless otherwise directed, the NAVigator backup file goes to the Downloads 
folder of the connected PC.

5.	 Click Keep to save the file to the Downloads folder or Discard as desired.

Restoring the NAVigator

Restore the NAVigator settings as follows:

1.	 If necessary, click the Menu icon (see figure 72, 1).
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Figure 72.	 Opening the Restore Configuration Page

2.	 If necessary, click Tools > Device Tools (2). The Device Tools page opens.

3.	 If necessary, click Restore (3).

4.	 Click Select File (4). An Open dialog box opens (see figure 73 on page 73).

5.	 Navigate to the folder where the backup file is saved (typically the Downloads folder) 
(see figure 73, 1). Select the file.
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Figure 73.	 Open Dialog Box

6.	 Click Open (2). The Device Tools page returns to the top (see figure 74).
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Figure 74.	 Device Tools — Restore Function

7.	 Select (click) the settings to restore (see figure 74, 1).
 

Communication settings Configuration settings

•	 Device Details — Device name •	 Device Details — Location

•	 Network connection •	 Date and time

•	 Ports •	 Advanced Networking — 
LLDP, Multicast Discovery IP•	 Advanced networking —Route add/static route

•	 Custom and favorite EDIDs

•	 WindoWall — Canvas and resets

•	 Ties*

*	 Restore Communication Settings and Restore Configuration Settings must both be checked.

8.	 Click Restore (2).	

The NAVigator reports that it is uploading 
the backup file and then that is restoring the 
settings. When the operation completes, the 
NAVigator reboots.

NOTE:	 To continue to operate the NAVIgator, you must reconnect (see Opening 
the Embedded HTML Pages on page 10).
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Firmware page

Upgrading the NAVigator firmware

Upgrade the NAVigator firmware, the built-in software that controls NAVigator operation, as 
follows:

NOTES:

•	 See Download a firmware or software package on page 123 to obtain the 
firmware package.

•	 Upgrading the NAVigator firmware results in the unit rebooting.

1.	 Access the HTML embedded HTML pages (see Opening the Embedded HTML 
Pages on page 10). The HTML page opens (see figure 75).

 

2.	 If necessary, click the Menu icon (see figure 75, 1).
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Figure 75.	 Device Firmware Upload Page

3.	 If necessary, click Tools > Device Tools (2).

4.	 Click Firmware (3).

5.	 Click Select File (4). An Open dialog box opens (see figure 76 on page 75).
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Figure 76.	 Open Dialog Box

6.	 Navigate to the folder where you saved the firmware upgrade file (see figure 76, 1). 
Select the file.

7.	 Click Open (2). The Open dialog box closes and the Device Tools page returns to the 
top, with the selected firmware file identified (see figure 77, 1).
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Figure 77.	 Device Page with Firmware File Identified

8.	 Click Update (2).

The NAVigator page displays a sequence that reports the progress as it uploads the file 
(see figure 78, 1), updates the firmware (2), and then reboots (3).

NOTE:	 Do not unplug the NAVigator while the firmware is been upgraded.
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Figure 78.	 Firmware Upload Progress

When the NAVigator reboots, the connection to it is momentarily lost and after a few 
seconds, the browser displays the home page Login dialog box (see figure 8 on 
page 11). To continue to operate the NAVigator, you must reconnect (see Opening the 
Embedded HTML Pages on page 10).
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Resetting the NAVigator

Reset or reboot the NAVigator settings as follows:

1.	 If necessary, click the Menu icon (see figure 79, 1).
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Figure 79.	 Opening the Restore Configuration Page

2.	 If necessary, click Tools > Device Tools (2). The Device Tools page opens.

3.	 If necessary, click Reset (3).

4.	 Select (click) the desired reset mode (4) or Reboot (5).

NOTES:	

•	 Reset Device Settings (Retains TCP/IP Settings and Password) — 
Resets configuration settings. All communication settings and the password 
are retained. See the table of communication and configuration settings on 
page 73.

•	 Reset All Settings and Delete Files (Retains TCP/IP Settings) — 
Resets configuration settings except the communication settings, which are 
maintained. Resets the password to the default, which is extron. See the table 
of communication and configuration settings.

•	 Reset All Settings and Delete Files — This reset is identical to the Mode 5 
reset (see the table of rear panel reset modes on page 9).

5.	 Click Apply (6).

The NAVigator reports that it is Resetting and displays a	  
status bar that shows the progress of the reset operation. 
When the operation completes, the NAVigator reboots.

NOTE:	 To continue to operate the NAVIgator, you must reconnect (see Opening 
the Embedded HTML Pages on page 10).
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System Tools page

Backing up the system

Backup the settings of multiple devices in the NAV system as follows:

NOTES:	

•	 Endpoints that are conflicted or offline are omitted from the system backup file. 
Check the Monitoring page to ensure that no endpoints report Offline or Conflicted 
(see Monitoring page on page 87). See Alarms on page 119 to remedy a 
conflicted or offline endpoint.

•	 Click the Filter drop-down menu (A) to show only endpoints by specific criteria.

1.	 If necessary, click the Menu icon (see figure 80, 1).
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Figure 80.	 Opening the System Backup Pane

2.	 If necessary, click Tools > System Tools (2). The System Tools page opens.

3.	 If necessary, click Backup (3).

4.	 Click the All checkbox (4) or individual endpoint checkboxes (5) to select one or more 
endpoints to backup.

5.	 Click Backup (6).	

The NAVigator creates a file of current system settings.

The NAVigator reports that the backup was 	  
file was successfuly created.

NOTE:	 Unless otherwise directed, the 
NAVigator backup file goes to the 
Downloads folder of the connected PC.
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Restoring the system configuration

Restore the system settings, including the NAVigator and endpoints, as follows:

1.	 If necessary, click the Menu icon (see figure 81, 1).
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Figure 81.	 Opening the Restore Configuration Pane

2.	 If necessary, click Tools > System Tools (2). The System Tools page opens.

3.	 If necessary, click Restore (3).

4.	 Select (click) the settings to restore (4).

NOTES:

•	 See the table of communication and configuration settings on page 73.

•	 The Transfer Endpoints to current NAVigator (requires reboot) selection (A) 
is a system transfer function to replace a NAVigator (see Transferring system 
configuration to a backup NAVigator on page 80).

Click Select File (5). An Open dialog box opens (see figure 82 on page 79).
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Figure 82.	 Open Dialog Box

5.	 Navigate to the folder where the backup file is saved (typically the Downloads folder) 
(see figure 82, 1). Select the file.

6.	 Click Open (2). The System Tools page returns to the top (see figure 83).
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Figure 83.	 System Tools — Restore Function

7.	 Click Next (see figure 83, 1).	

The NAVigator reports that it is Restoring and then 
Rebooting and displays a status bar that shows the 
progress of the Restore operation. When the operation 
completes, the NAVigator reboots.
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Transferring system settings to a replacement NAVigator

NOTES:

•	 This procedure is a restore option to recover your system if a NAVigator fails. It 
allows a replacement NAVigator to assume NAV system management if necessary.

•	 This procedure assumes that you have already created a system backup file (see 
Backing up the system on page 77).

Transfer the endpoints to backup NAVigator as follows:

1.	 Disconnect the original NAVigator and remove it from the system. Mount and connect 
the replacement NAVigator (see Installation and Operation on page 4).

2.	 Connect to the replacement NAVigator via the embedded HTML pages (see Opening 
the Embedded HTML Pages on page 10).

3.	 Configure the replacement NAVigator with the proper IP addressing for your setup, 
whether that is static or DHCP-assigned IP addressing (see Network Connection 
Settings on page 23).

4.	 Open the system restore page — Perform steps 1 through 3 of Restoring the 
system configuration on page 78.

5.	 Select (click) Transfer Endpoints to current NAVigator (requires reboot) (see 
figure 84, 1).
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Figure 84.	 Transferring System Configuration

NOTE:	 This selection also automatically selects Restore Configuration Settings 
(requires reboot) (A).

6.	 Click Select File (2). An Open dialog box opens (see figure 85 on page 81).
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Figure 85.	 Open Dialog Box

7.	 Navigate to the folder where the backup file is saved (typically the Downloads folder) 
(see figure 85, 1). Select the file.

8.	 Click Open (2). The System Tools page returns to the top (see figure 86).

111111111111111111

222222222222222222

Figure 86.	 System Tools — Restore Function During Transfer

9.	 Enter the Password (see figure 86, 1) used by the original NAVigator when the system 
backup file was created.

10.	Click Next (2).
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The restore process of the endpoints 	

Figure 87.	 Transfer Endpoints Progress
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settings is reported in the In process field 
(see figure 87, 1).

The restore process of the endpoints is 
complete and the endpoints are rebooting 
as indicated in the In process field (2).

As endpoints complete their reboot, they 
are indicated in the Complete field (3).

Once the endpoints are all complete, The 
NAVigator settings are restored (4).

Once its configuration settings are 
restored, the NAVigator reboots.

When the NAVigator reboots, the 
connection to it is momentarily lost and 
after a few seconds, the browser displays 
the home page Login dialog box (see figure 8 on page 11).

11.	After the reboot, reconnect to the replacement NAVigator via the embedded HTML 
pages (see Opening the Embedded HTML Pages on page 10).

The replacement NAVigator has now taken over management of the NAV system.
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Upgrading the system firmware

Upgrade the firmware of multiple devices in the NAV system as follows:

NOTES:

•	 See Download a firmware or software package on page 123 to obtain the 
firmware package.

•	 Upgrading the system firmware results in the NAVigator rebooting.

1.	 Access the HTML embedded HTML pages (see Opening the Embedded HTML 
Pages on page 10). The HTML page opens (see figure 88).

 

2.	 If necessary, click the Menu icon (see figure 88, 1).
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Figure 88.	 System Firmware Upload Page

3.	 If necessary, click Tools > System Tools (2).

4.	 Click Firmware (3).
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5.	 Click Select File (see figure 88, 4 on page 83). An Open dialog box opens (see 
figure 89).
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Figure 89.	 Open Dialog Box

6.	 Navigate to the folder where you saved the firmware or software file 
(typically, the Downloads folder, see figure 89, 1). Select the file.

7.	 Click Open (2). The Open dialog box closes and the Device Tools page returns to the 
top, with the selected firmware file first shown as uploading and then identified (see 
figure 90, 1).
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Figure 90.	 Device Pane with Firmware File Identified

8.	 Click Next (2).

The NAVigator page displays a page where you can select endpoints to upgrade (see 
figure 91 on page 85).
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Figure 91.	 Firmware Endpoint Selection

9.	 Click the All checkbox (see figure 91, 1) or individual endpoint checkboxes (2) to 
select one or more endpoints to upgrade.

NOTES:

•	 The upgrade to the NAVigator itself, if selected, is	  
always performed last so that the NAVigator can 
manage the upgrades of the endpoints.

•	 Some firmware updates may not apply to some 
endpoints, such as updates for 1G endpoints only 
and updates for 10G endpoints only. If desired, select 
Filter > Model to filter your endpoints.

10.	Click Update (3). The NAVigator page displays a series of messages that show the 
sequence of the firmware update (see figure 92, 1 on page 86).
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The system firmware upgrade has started	

Figure 92.	 Firmware Upgrade in Progress
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(see figure 92, 1).

The firmware update to the endpoints is in 
progress in the In process field (2).

The firmware update to the endpoints is 
complete and the endpoints rebooting is 
indicated in the In process field (3).

As endpoints complete their reboot, they 
are indicated in the Complete field (4).

NOTE:	 Depending on the products in 
your system, the firmware Upgrade 
may require several cycles, one for 
each unique firmware package. For 
example, 1G endpoints require a 
separate upgrade cycle from 10G 
endpoints.

Once the endpoints are all complete, The 
NAVigator firmware updates (5). Once 
its firmware is updated, the NAVigator 
reboots.

On reboot, the connection to the 
NAVigator is lost and the browser 
displays the home page Login dialog box 
(see figure 8 on page 11). To continue 
to operate the NAVigator, you must 
reconnect (see Opening the Embedded 
HTML Pages on page 10).
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Monitoring Page
1.	 If necessary, click the Menu icon (see figure 93, 1).
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Figure 93.	 Monitoring Page

2.	 If necessary, click Monitoring (2).

A	 Offline Endpoints pane — See Offline Endpoints pane on page 88.

B	 Conflicted Endpoints pane — See Conflicted Endpoints pane on page 89.

C	 IGMP Querier pane — See IGMP Querier pane on page 90.

D	 Control Systems pane — See Controls Systems on page 90.

E	 Alarms pane — See Alarms pane on page 91.

F	 Alarm Settings Link — See Alarms pane.

G	 Download Logs link — See Download Logs link on page 92.
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Offline Endpoints pane
The Offline Endpoints pane (see figure 93, A on page 87) shows the number, if any, of 
discovered endpoints that are not reporting their status.

Figure 94 shows the indication if an endpoint is offline. Click Learn More (1) to identity the 
offline endpoint (2).
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Figure 94.	 Identifying and Unassigning an Endpoint

See Alarms on page 119 to bring the endpoint back online. The indication is self-clearing.

To remove an undesired endpoint from the system, perform the following:

1.	 Click the All checkbox (3) or individual endpoint checkboxes (4) to select one or more 
endpoints to unassign.

2.	 Click Unassign (5).
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Conflicted Endpoints pane
The Conflicted Endpoints pane (see figure 93, B on page 87) shows the number, if any, 
of discovered endpoints that have an assignment conflict within the system.

Figure 95 shows the indication if an endpoint is conflicted. Click Learn More (1) to identity 
the conflicted endpoint (2).

111111111111111111

222222222222222222

555555555555555555
666666666666666666

444444444444444444

333333333333333333

Figure 95.	 Identifying and Resolving an Endpoint Conflict

NOTE:	 A conflict exists when either of the following conditions is present:

•	 An endpoint indicates it is assigned to a NAVigator, but that NAVigator doesn’t 
include this endpoint in its list of assigned endpoints.

•	 A NAVigator lists an endpoint in its list of assigned endpoints, but that endpoint 
indicates that it is unassigned.

To resolve system conflict, perform the following:

1.	 Click the All checkbox (3) or individual endpoint checkboxes (4) to select one or more 
endpoints to resolve.

2.	 Click Assign to reassign the endpoint to this NAVigator or Unassign (5) to release the 
endpoint from this NAVigator (6).
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IGMP Querier pane
An IGMP querier is a network service that runs on a network switch and manages the IGMP 
network traffic. An IGMP querier should be configured on the NAV network. It manages the 
multicast traffic. If there is no IGMP querier on the network, there is no effective multicast 
traffic management and the multicast traffic saturates the network and stream errors can 
occur.

The IGMP Querier pane (see figure 93, C on page 87) shows whether or not an IGMP 
querying device is present on the network, and the IP address of the IGMP querier. The 
address allows you to know that you are communicating to a querier and which querier. In 
the case of duplicate querier, the IP address may change. Figure 96 shows the indication if 
no IGMP querier is present on the network or if there are multiple IGMP queriers and there 
should only be one.

Figure 96.	 IGMP Querier Pane with no IGMP Querier Present on the Network

NOTE:	 If no IGMP querier is discovered, contact your network administrator. An IGMP 
querier is a required network resource for the NAV System to function correctly.

Control Systems pane
The Control Systems pane (see figure 93, C on page 87) shows the status 	  
of control systems that are paired and connected to the NAVigator. The 
leftmost shown number at right indicates the number paired. The rightmost number 
indicates the number connected.

Figure 97 shows the indication if no control system is paired (on the left) and if none is 
connected (on the right). Click Learn More (1) to see detailed connection and pairing 
information (see figure 98).
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Figure 97.	 Control Systems Pane

Figure 98.	 Detailed Control Systems Connection and Pairing Information
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Alarms pane
The Alarms pane (see figure 93, D on page 87) shows any alarms that have been triggered 
in the NAV system managed by this NAVigator. Figure 99 shows the pane when alarms are 
present. Some alarms self-clear when specific conditions are met, others remain as long as 
the conditions that cause them remain. As an example, a temperature alarm remains until 
the NAVigator cools down.
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Figure 99.	 Clearing Alarms

ATTENTION:

•	 Critical alarms ( ) should be resolved immediately.

•	 Warning alarms ( ) are less serious.

Manually clear one or more alarms from the system as follows:

1.	 Click Learn More (see figure 99, 1).

2.	 Click the All checkbox (2) or individual endpoint checkboxes (3) to select one or more 
alarms to clear.

3.	 Click Clear Alarms to clear the alarm (4).
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Configure which alarms are and are not reported in this pane as follows:

1.	 Click Alarm Settings (see figure 99, 5). The Edit Alarms Settings dialog box opens 
(see figure 100).
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Figure 100.	 Alarm Settings Window

2.	 Click the Status switch (1) to enabled ( ) and disable ( ) alarm reporting.

3.	 Click Save (2) to make the changes or Cancel (3) to abandon them.

Download Logs
Click the Download Logs link (see 1	
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at right) to download a history of errors 
in a comma-delimited .csv file that can 
be opened in Microsoft Excel. The 
figure at right shows the results of 
downloading an alarms log using the 
Chrome browser (2).

NOTE:	 There is no upper limit to the number of alarms that can be logged, but a device 
can only have one alarm of the same type active at a time. The NAVigator monitors 
the active alarm states of all devices in the NAV system. All alarm state changes are 
logged even if status reporting is disabled from the NAVigator.
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Settings Page

Editing device details

NOTE:	 Name and Location can also be edited from the Configure Endpoints > General 
tab (see Add and edit names, tags, and locations on page 33).

Edit the name and location as follows:

1.	 If necessary, click the Menu icon (see figure 101, 1).
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Figure 101.	 Device Details Pane

2.	 If necessary, click Settings (2).

3.	 If necessary, click Device Details (3). The HTML page displays read-only information 
about the NAVigator.

4.	 Click Edit (4) to make the Device Name and Location available for editing (see 
figure 102 on page 94). The Edit button changes to Save.
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Figure 102.	 Editing Device Details

5.	 Click in the appropriate field and make changes as necessary (see figure 102,1).

NOTE:	 See the NOTES on page 34 for the text rules that apply to names and 
locations.

6.	 Click anywhere outside the edited field.

7.	 Click Save (6).
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Setting date and time
Set the date and time as follows:

1.	 If necessary, click the Menu icon (see figure 103, 1).
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Figure 103.	 Date & Time Pane

2.	 If necessary, click Settings (2).

3.	 If necessary, click Date & Time (3).

4.	 To set the time manually, click Set Manually (4) and see Set manually on page 96.

To sync the time with the server, click Sync With Server (5) and see Sync with 
server on page 98.
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Set manually

1.	 If necessary, click Set Manually (see figure 104, 1).
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Figure 104.	 Set Time and Date Manually

2.	 Click Edit (2) to make the Date & Time available for editing (see figure 105).
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Figure 105.	 Set Time and Date Manually

3.	 To sync the NAVigator to your computer, click Set From PC (see figure 105, 1).
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4.	 To manually set the time and date, click in the appropriate field and make changes 
as necessary (see figure 105, 2 on page 96).

NOTE:	 Or you can click the Datepicker ( ) or Timepicker ( ) icons (see figure 106) 
and use those tools to set the date and time.

Figure 106.	 Datepicker and Timepicker Tools

5.	 If desired, click the Time Zone drop-down menu (3) to select among the time zones.

6.	 Click Save (4).
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Sync with server

1.	 If necessary, click Sync With Server (see figure 107, 1).
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Figure 107.	 Sync with Server

2.	 Click Edit (2) to make the Date & Time available for editing. The Edit button changes to 
Save.

3.	 Click in the appropriate field and make changes as necessary (see figure 107,3).

NOTE:	 The entry must be in the valid IP address or domain name format.

4.	 Click anywhere outside the edited field.

5.	 Click Sync Now (4) to synchronize the time with the configured time server.

6.	 Click Save (5).
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Network Connection
Using the Network Connection tools is fully described in Network Connection Settings on 
page 23.

Changing the Password
Change the password as follows:

NOTE:	 When you change the NAVigator Admin password, the new password is 
automatically pushed to all assigned endpoints.

1.	 If necessary, click the Menu icon (see figure 108, 1).
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Figure 108.	 Username/Password Page

2.	 If necessary, click Settings (2).

3.	 If necessary, click Username/Password (3).

4.	 Click Edit (4) to make the Password available for editing. The Edit button changes to 
Save.
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5.	 Enter the new password in the Admin Password field (see figure 109, 1) and Confirm 
Admin Password field (2).
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Figure 109.	 Changing the Password

NOTE:	 A valid password meets the following requirements:

•	 The length is up to 128 characters.

•	 All alpha-numeric characters and ASCII symbols are permitted except | (pipe).

•	 The password cannot be blank.

•	 The password cannot start with a space.

TIP:	 Select (click) the Show Password checkbox (A) to display the password as 
you type it.

6.	 Click Save (3).
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Loading a LinkLicense
A LinkLicense is a key that unlocks additional or enhanced features of an Extron product, 
such as increasing the number of supported endpoints. Contact the Extron S3 Sales and 
Technical Support Hotline (see www.extron.com for the phone number in your region of 
the world) to obtain a LinkLicense.

Load a LinkLicense as follows:

1.	 If necessary, click the Menu icon (see figure 110, 1).
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Figure 110.	 Opening the LinkLicense Page

2.	 If necessary, click Settings (2).

3.	 If necessary, click LinkLicense (3). The LinkLicense page opens.

4.	 Click Select File (4). An Open dialog box opens (see figure 111 on page 101).

http://www.extron.com
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Figure 111.	 Open Dialog Box

5.	 Navigate to the folder where the LinkLicense is saved (see figure 111, 1). Select the 
file.

NOTE:	 A valid LinkLicense has the extension ell. Any other file type is NOT a valid 
LinkLicense.

6.	 Click Open (2). The LinkLicense page returns to the top (see figure 112).
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Figure 112.	 Device Tools — Restore Function

7.	 Click Update (see figure 112, 1).

The NAVigator reports that it is Uploading	  
and then Installing the license.

NOTE:	 To continue to operate the 
NAVigator, you must reconnect (see 
Opening the Embedded HTML Pages 
on page 10).
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Changing the Port Settings
Set the port settings as follows:

1.	 If necessary, click the Menu icon (see figure 113, 1).
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Figure 113.	 Ports Page

2.	 If necessary, click Settings (2).

3.	 If necessary, click Ports (3).

4.	 Click Edit (4) to make the Ports available for editing. The Edit button changes to Save.

5.	 If desired, click in the HTTPS field (see figure 114, 1 on page 104) and make changes 
as necessary.
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Figure 114.	 Changing the Port Parameters

NOTES:

•	 The valid range for the HTTPS field is 0, 443, and 1024 through 65535.

•	 The valid range for the SSH/SIS field is 0 (disable the port) and 1024 through 
65535.

6.	 If desired, click in the SSH/SIS field (see figure 114, 2) and make changes as 
necessary.

7.	 Click anywhere outside the edited field.

8.	 Click Save (3).
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Changing the Advanced Networking Settings
Set the port settings as follows:

1.	 If necessary, click the Menu icon (see figure 115, 1).
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Figure 115.	 Username/Password Page

2.	 If necessary, click Settings (2).

3.	 If necessary, click Advanced Networking (3). See the definitions of these values in the 
NOTES on page 106.

4.	 Click Edit (4) to make the Device Settings available for editing. The Edit button 
changes to Save.
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5.	 If desired, click the Link Layer Discover Protocol (LLDP) switch (see figure 116, 1) to 
toggle LLDP on and off.
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Figure 116.	 Changing the Port Parameters

6.	 If desired, click in the appropriate IP address fields and make changes as necessary (2).

NOTES:

•	 LLDP is a link layer protocol used by NAV devices to advertise their identity, 
capabilities, and neighbors on a local area network.

•	 Multicast Discover IP is an identical multicast discovery IP address 
(Default: 239.255.255.254) that is used for discovery and communication 
purposes across the NAV system.

•	 The Route Add/Static Route provides a single static route in the NAVigator for 
accessing endpoints located on remote subnets.

•	 The Network Address and Subnet Mask fields define the remote subnets 
using the shortest prefix mask possible.

•	 The Next Hop IP Address is the IP address of the gateway that has access 
those remote subnets.

7.	 Click anywhere outside the edited field.

8.	 Click Save (3).
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About Page
Access the About page by clicking About (see figure 117, 1).
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Figure 117.	 About Page

The About page provides the following useful information:

A	 Firmware version number

B	 Installed licenses, which can be sorted by click the desired filtering letter
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Control System

This section includes:

•	 Secure Platform Device

•	 Toolbelt

•	 Global Configurator Plus

•	 Global Scripter

The NAVigator can be remotely controlled from a host device such as a computer or Extron 
control system. The controlling device is connected via the NAVigator rear panel NAV/PoE 
port (see figure 2, B on page 5) or OOB port (C).

Secure Platform Device
As a Secure Platform Device (SPD), the NAVigator communicates with compatible 
controllers such as Extron IPCP Pro and IPL Pro series control products over a secure, 
encrypted channel. The NAVigator hosts multiple Secure Platform Interfaces, exposing 
control of the entire NAV system to connected primary controllers.

Toolbelt
The Extron Toolbelt utility is available on the Extron website. Toolbelt is a stand-alone 
Windows® application for the management of control systems. Toolbelt can automatically 
discover Pro Series and NAV devices on a network (see the Toolbelt Help file). You can also 
manually add devices, using the known IP addresses. Once you log in to a NAV device, 
such as a NAVigator, you can perform tasks such as:

•	 Launch the embedded NAVigator HTML page after discovery

•	 View the device and system information

•	 View and edit network information

•	 View and set SSL certificates

•	 Use utilities such as Ping, Reset, and Reboot

•	 View 802.1x status logs

•	 Configure 802.1x security settings

•	 Update the firmware to a selected device or group of devices
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Global Configurator Plus

NOTE:	 NAV Products can be used in control systems with the following Extron control 
products:

•	 IPCP Pro Processors such as the IPCP Pro 250

•	 IPL Pro Control Processors such as the IPL Pro S3

Global Configurator is an Extron control system configuration software for use in AV systems 
that include Extron Pro Series control products. Conditional logic, variables, and macros 
provide flexibility for elaborate control system designs. No direct programming knowledge is 
needed to use the program.

The functional logic is built in to Global Configurator; you merely select the functions that 
you want to use. You can quickly set up schedules, macros , monitors, and the like, using 
available actions and commands, without having to write control script.

Global Configurator has two modes:

•	 Global Configurator Plus — Ideal for smaller applications requiring one control 
processor and one control interface.

•	 Global Configurator Professional — Suited for applications requiring multiple control 
processors, enhanced functionality, and advanced configuration. Access to Global 
Configurator Professional requires ECP Certification.

In a NAV system with an Extron controller, such as an IPCP Pro 250, you can perform 
actions such as:

•	 Load device drivers for monitoring the status of and controlling devices with the NAV 
system.

•	 Upload GUI Designer interface layouts to touchpanels and third-party touch interfaces.

•	 Create the configuration containing all the settings for the control process and the 
products with which it interacts in the NAV system.

•	 Upload the configuration to the control processor.

•	 Send limited commands (such as some SIS commands) via the controller to a NAV 
device (but without receiving a response from the device).

To obtain Exton control product software, you must have an Extron Insider account and 
contact an Extron support representative on the Extron S3 Sales and Technical Support 
Hotline (see www.extron.com for the phone number in your region of the world). Extron 
provides training to our customers on how to use the software. Access to the features of 
Global Configurator Professional is available to users who successfully complete Extron 
Control Professional Certification.

For detailed descriptions and procedures to setup a control system with an IPCP Pro device 
and Global Configurator, see the applicable Global Configurator Help file.

http://www.extron.com
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Global Scripter

NOTE:	 NAV Products can be used in control systems with the following Extron control 
products:

•	 IPCP Pro Processors such as the IPCP Pro 250

•	 IPL Pro Control Processors such as the IPL Pro S3

Global Scripter is powerful and versatile control system programming software from Extron 
for AV systems that use an Extron Pro series control processor (such as an IPCP Pro 250). 
Global Scripter, being programming (rather than just configuration) software, is much more 
flexible than Global Configurator. Global Scripter allows an integrator to write customized 
programs for a his or her specific AV system. Using customized programming commands 
for configuration and control allows larger AV systems than Global Configurator.

Global Scripter uses the easy-to-learn Python scripting language and includes the Extron-
exclusive Python library: ControlScript. ControlScript increases the productivity of AV 
programmers by incorporating functions used in common AV control system projects, as 
well as helpful documentation, reference material, and sample code. Global Scripter can 
insert specific AV devices (such as SPDs) and functions into the code.

In a NAV system with an Extron controller, such as an IPCP Pro 250, you can support many 
more devices (system controllers, NAVigators, and endpoints) than Global Configurator, 
send very specific SIS commands (as programmed code) and get feedback.

NOTE:	 Users and integrators must know how to program with Python and should know 
how to use Extron ControlScript.

For detailed descriptions and procedures to setup a control system with an IPCP Pro device 
and Global Scripter, see the Global Scripter Help file.
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SIS Operation

The NAVigator can be remotely controlled, monitored, or configured using the following:

•	 A user-defined string consisting of SIS commands (see below)

•	 Extron Toolbelt or a control system constructed using either Global Configurator Plus, 
Global Configurator Pro, or Global Scripter (see Control System on page 108)

•	 Built-in HTML pages (see HTML Operation on page 10)

This section provides guidance on operation of the NAVigator via a string of commands and 
lists the SIS commands, including:

•	 Host-to-NAVigator Communications

•	 NAVigator-Initiated Power-Up Message

•	 NAVigator Error Responses

•	 Using the Command and Response Table

•	 SIS Command and Response Table

•	 NAVigator to Endpoints Communication (Encapsulation)

As an SPD (see Secure Platform Device on page 108), communication is by using Global 
Configurator Plus, Global Configurator Professional, or Global Scripter, via an SPD interface. 
See the applicable Help file to configure the program to issue command strings to the 
NAVigator.

NOTE:	 You can connect the NAVigator to a control system using either the OOB or NAV 
LAN port.

Host-to-NAVigator Communications
SIS commands consist of one or more characters per field. No special characters are 
required to begin or end a command character sequence. When a command is valid, the 
device executes the command and sends a response to the host device. All responses from 
the device to the host end with a carriage return and a line feed (CR/LF = ]), which signals 
the end of the response character string. A string is one or more characters.

NAVigator-Initiated Messages
© Copyright 20yy, Extron Electronics NAVigator, Vx.xx, 60-nnnn-nn]

The NAVigator has completed its start-up. Vx.xx is the firmware version number and 
60-nnnn-nn is the part number.

DevpA*<endpoint>*<0 = unassigned, 1 = assigned>]

The assigned status of an endpoint has changed.

DevpP*<endpoint>*<0 = offline, 1 = online>]
An assigned endpoint has changed its online status.
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NAVigator Error Responses
When the NAVigator receives a valid SIS command, it executes the command and sends a 
response to the host device. If the NAVigator is unable to execute the command because 
the command is invalid or it contains invalid parameters, the NAVigator returns an error 
response to the host. The error response codes are:

E10 — Invalid command 
E12 — Invalid port number 
E13 — Invalid parameter 
E14 — Invalid for this configuration 
E17 — Invalid command for signal type 
E22 — Busy 
E24 — Privilege violation 
E25 — Device not present 
E28 — Bad file name or file not found

Using the Command and Response Tables
The command and response tables begin on page 113. Symbols are used throughout 
the tables to represent variables in the command and response fields. Command and 
response examples are shown throughout the tables. The ASCII to HEX conversion table 
below is for use with the command and response table.

ASCII to Hex  Conversion Table

•

Space

Common symbol definitions
]	 =	 Carriage return/line feed	 •	 =	 space

}	 =	 Carriage return (no line feed)	 E	 =	 Escape key

|	 =	 Pipe (can be used interchangeably with the } character)	 W	 =	 Can be used interchangeably with the E character
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SIS Command and Response Tables

Command and Response Table for NAVigator Commands

Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

NOTES:
•	 The NAVigator supports 1- through 4-digit numeric entries (such as 1*1, 0002*0002). Leading zeroes are not required.
•	 Commands can be entered back-to-back in a string, with no spaces. For example: 1*1!02*02&03*03%4*8!.

Video, audio, and USB ties

NOTES:
•	 The X! and X@ variables can be in any of three formats: input or output number, device name (case-sensitive), or IP address.
•	 For AV ties, X! indicates the input and X@ indicates the output. For USB ties, X! indicates the host and X@ indicates the USB device.
•	 An input and an output can both have the same number, such as input 1 and output 1. For USB ties where X! and X@ are 

I/O numbers, another variable, X#, is necessary to clarify whether the device is an input or output. X# is not necessary for ties 
commanded by device name or IP address.

•	 For AV ties, do NOT include the X# variable; an alarm will occur.

Tie input X! video and audio to output X@ EX!*X@!} OutX@•InX!•All] Tie input X! video and audio to output X@.

Example using I/O numbers: E1*3!} Out03•In01•All] Tie input 1 video and audio to output 3. 

Tie input X! video to output X@ EX!*X@%} OutX@•InX!•Vid] Tie input X! video to output X@.

Example using device names: EEncoder1*Classroom2%} Tie video from encoder 1 to classroom 2.

OutClassroom2•InClassroom1•Vid]

Tie input X! audio to output X@ EX!*X@$} OutX@•InX!•Aud] Tie input X! audio to output X@.

Example using IP addresses: E192.168.1.10*192.168.1.12$} Tie input 192.168.1.10 audio to output 
192.168.1.12.Out192.168.1.12•In192.168.1.10•Aud]

Tie host X!X# USB to device X@X# EX!X#*X@X#^} OutX@X#•InX!X#•Usb] Tie host X!X# USB to device X@X#.

Example encoder as host, using I/O 
numbers:

E2026i*436o^} Out436o•In2026i•Usb] Tie encoder 2026 to decoder 436 as a host.

Example using device names: Elabo*class1i^} Outclass1•Inlab•Usb] Tie lab to class1 as a host.

Example using IP addresses: E192.168.1.8*192.168.1.9^} Tie input 192.168.1.8 to 192.168.1.9 as a 
host.Out192.168.1.9•In192.168.1.8•Usb]

Tie input X! video and audio to all outputs EX!*!} X!•All] Tie input X! video and audio to all outputs.

TIP:	 When you create a tie where X! = 00, you tie no input (AV ties) or no host (USB ties) to the specified output or device (X@) (untie X@).

•	 E0*!] clears all AV ties.
•	 E0i*^] clears all USB ties.

Tie input X! video to all outputs EX!*%} X@•Vid] Tie input X! video to all outputs.

Tie input X! audio to all outputs EX!*$} X@•Aud] Tie input X! audio to all outputs.

Untie an AV output E00*X@!} OutX!*In00*All] Untie output from input.

Untie an AV input EX!*00!} Out00*InX!*All] Untie input from all outputs.

KEY:	 X! = Input (AV) or host (USB)	 Number: 0000 or <input number> (0000 = untie outputs) 
	 Name: <name> 
	 IP address: <xxx.xxx.xxx.xxx> 
X@ = Output (AV) or USB device (USB)	 Number: 0000 or <output number> (0000 = untie input) 
	 Name: <name> 
	 IP address: <xxx.xxx.xxx.xxx> 
X# = Encoder (input) or decoder (output)	 Only first letter (i or o) is valid. (Required for USB ties by I/O number only)

NOTE:	 See Configure Selected Endpoint Communication Settings on page 27 to edit input and output numbers and IP addresses. 
See Add and edit names, tags, and locations. on page 33 to edit input and output names.
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Video, audio, and USB ties (continued)

NOTES:
•	 The quick multiple tie and tie input to all output commands make all ties simultaneously.

•	 If any commanded ties in a multiple tie command are invalid, all valid ties are made and the response is Qik14 to indicate the error.

Quick multiple tie E+QX!*X@!...X!*X@&}

Qik]
Example: E+Q3*4!3*5%3*6$} Tie input 3 video and audio to output 4, tie 

input 3 video only to output 5, and tie input 3 
audio only to output 6.

Qik]

WindoWall presets
Recall WindoWall preset (per canvas) ER1*X$*X%PRST} PrstR1*X$*X%]

View last recalled preset (per canvas) EL1*X$PRST} X% X% is the last recalled preset.

Select WindoWall input
Select input EX$*X^*X!} GrpX$*X^*X!] Select input X! to Window X^ on Canvas X$.

View current input EX$*X^} X!]

WindoWall video mute
Mute Window X$*X^*1B VmtX$*X^*1] Mute window X^ canvas X$.

Unmute Window X$*X^*0B VmtX$*X^*0] Unmute window X^ canvas X$.

View Mute Status X$*X^B Y!] Mute status of window X^ canvas X$ is Y! .

Verbose mode 2 or 3: VmtX$*X^*Y!]

Information requests
View video and audio tie EX@!} X!] This command, when audio is broken away in 

the tie, returns an E13 error.

View video tie EX@%} X!]

View audio tie EX@$} X!]

Show NAV system size I VX&XX*•AX&XX*] Show the total number of encoders and 
decoders assigned to this NAVigator.

View model name 1I NAVigator]

View model description 2I NAV•System•Manager]
View number of connected users 10I X(]

View IGMP querier 50I X1)]

View device serial number 98I X1!]

View internal temperature E20STAT} X1@]

View LinkLicense status ELELIC} See below for an example:

{“licensedFeature”:[{“name”:”<variable>”,”description”:”Link License nn Endpoints”,”status”:true,”serialNumber”: 
”<variable>”,”expirationDate”:<nnnnnnnnn>,”data”:”<n>”,”part_number”:”79-<nnnn>-<nn>”}}]}]
View part number N 60-nnnn-01]

KEY:	 X! = Input (AV) or host (USB)	 Number: 0000 or <input number> (0000 = untie outputs) 
	 Name: <name>	 IP address: <xxx.xxx.xxx.xxx> 
X@ = Output (AV) or USB device (USB)	 Number: 0000 or <output number> (0000 = untie input) 
	 Name: <name>	 IP address: <xxx.xxx.xxx.xxx> 
X$ = Canvas number	 1 — 8 
X% = Preset number	 1 — 8 
X^ = Window number	 1 — 64 
Y! = Mute Status	 1= muted, 0 = unmuted 
X& = Total number of inputs 
X* = Total number of outputs 
X( = Number of connected users	 0 through 15 
X1) = IP address	 xxx.xxx.xxx.xxx 
X1! = Serial number	 <xxxxxxx> 
X1@ = Internal temperature	 xxxF•xxC

NOTE:	 If tagged responses are enabled, all read and view commands return the constant string and the value as the set command does 
(for example, the read matrix name command, ECN} returns Ipn•X1^]).
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Firmware version
Read firmware version Q X1#]
Read full firmware version *Q X1$]
Read advanced firmware version 20Q X1%]
Device name
Set NAVigator name EX1^CN} Ipn•X1^]

Read NAVigator name ECN} X1^]

Reset NAVigator name to factory default E•CN} Ipn•X1^] “NAVigator-” plus the last 3 pairs of the 
MAC address.

Verbose mode

NOTE:	 Verbose mode affects all responses from the NAV system, not just those from the NAVigator.

Set verbose mode EX1&CV} VrbX1&]

Read verbose mode ECV} X1&]

Miscellaneous device commands
View device online status EP*X1*DEVP} X1(] The response will appear unsolicited if a unit 

changes its online state.Verbose mode 2 or 3: DevpP*X1**X1(]

Example: EP*23iDEVP} 1] Encoder 23 is online.

View device assignment status EA*X1*DEVP} X1(] The response will appear unsolicited if a unit 
changes its assigned state.

Example: EA*4001oDEVP} 0] Decoder 4001 is not assigned.

Verbose mode 2 or 3: DevpA*4001o*0]

Absolute system reset EZQQQ} Zpq]

KEY:	 X1# = Firmware version	 x.xx 
X1$ = Full firmware version	 x.xx.xxxx 
X1% = Advanced firmware version	 x.xx.xxxx-bxxxx 
X1^ = Unit (host) name	 Up to 63 alphanumeric characters 
X1& = Verbose mode	 0 = Clear or none (default)	 2 = Tagged responses for queries 
	 1 = Verbose mode	 3 = Verbose mode and tagged for queries 
X1* = Endpoint number	 nnnni (for input) or nnnno (for output) 
X1( = Status	 0 = Offline, unassigned	 1 = Online, assigned

NOTE:	 If tagged responses are enabled, all read and view commands return the constant string and the value as the set command does 
(for example, the read matrix name command, ECN} returns Ipn•X1^]).
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Command and Response Table for IP-Specific SIS Commands

Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

DHCP client
Set DHCP on EX2!*1DHCP} Dhcp•X2!*1]

Set DHCP off EX2!*0DHCP} Dhcp•X2!*0]

View DHCP status EDHCP} X2#]

IP address
Set IP address EX2!*X2$CISG} Cisg•X2!*X2$]

IP and subnet mask
Set IP address and subnet mask EX2!*X2$IP*X2$SubnetCISG} Cisg•X2!*X2$IP/X2@Subnet*X2$Gateway]

Set IP address and subnet mask EX2!*X2$IP/X2@SubnetCSIG} Cisg•X2!*X2$IP/X2@Subnet*X2$Gateway]

IP, Subnet, and gateway address all at once
Set IP address, subnet address, 
and gateway

EX2!*X2$IP*X2$Subnet*X2$GatewayCISG}

Cisg•X2!*X2$IP/X2@Subnet*X2$Gateway]

Set IP address, subnet address, 
and gateway

EX2!*X2$IP/X2@Subnet*X2$GatewayCISG]

Cisg•X2!*X2$IP/X2@Subnet*X2$Gateway]

View IP address, subnet address, 
and gateway

EX2!*CISG} X2$IP/X2@Subnet*X2$Gateway]

DNS address
Set DNS address EX2!*X2$1*X2$2*X2$3DNSS} Sets DNS servers for the NAVigator. 

You can list up to 3 DNS servers (X2@s).IpdX2$]

Clear all DNS addresses EX2!*0DNSS]

View DNS adress EX2!DNSS} X2$]

MAC address
View MAC address ECH} X2%]

Verbose mode 2 or 3: Iph•X1(]

Report inventories
Report input inventory EInventory*I*RPRT} X2^1X2^2X2^3 ... X2^4096] View the connection status of all 

inputs.Verbose mode 2 or 3: Rprt*Inventory*I*X2^1 ...]

Report output inventory EInventory*O*RPRT} X2^1X2^2X2^3 ... X2^4096] View the connection status of all 
outputs.Verbose mode 2 or 3: Rprt*Inventory*O*X2^1 ...]

KEY:	 X2! = Network interface	 1 = OOB LAN interface	 2 = NAV LAN interface 
X2@ = Subnet prefix	 Number of bits used to create the subnet 
X2# = Status	 0 = Off, disabled, not detected	 1 = On, enabled, detected 
X2$ = IP address, subnet, or gateway address	 xxx.xxx.xxx.xxx 
X2% = MAC address	 00-05-A6-xx-xx-xx  
X2^ = Endpoint inventory	 0 = No device or unassigned	 1 = Device online	 2 = Device offline
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Report ties

Report all AV ties ETies*A*RPRT} Rprt•ties]

Output	 InVid	 InAud] 
a	 X!	 X!] 
b	 X!	 X!] 
c	 X!	 X!] 
•	 •	 •] 
•	 •	 •] 
n	 ---	 ----] 
•	 •	 •] 
•	 •	 •] 
X*	 X!	 X!]]

View the input tied to all outputs 
assigned to the NAVigator.

The columns in the reports are tab-
deliminated.

Dashes indicate no tie.

Only outputs assigned to this 
NAVigator (regardless of online or not) 
are listed in the report. 

Report all USB ties ETies*U*RPRT} Rprt*ties*U]

Device	 Host] 
X2&X#	 X2*X#] 
X2&X#	 X2*X#] 
X2&X#	 X2*X#] 
•	 •] 
•	 •] 
-----	 -----] 
•	 •] 
•	 •] 
X2&X#	 X2*X#]]

View the USB ties of the endpoints 
connected to the NAVigator.

The columns in the reports are tab-
deliminated.

NOTES:
•	 The quick multiple tie and tie input to all output commands make all ties simultaneously.

•	 If any commanded ties in a multiple tie command are invalid, all valid ties are made and the response is Qik14 to indicate the error.

KEY:	 X! = Input (AV) or host (USB)	 Number: 0000 or <input number> (0000 = untie outputs) 
	 Name: <name> 
	 IP address: <xxx.xxx.xxx.xxx> 
X* = Total number of outputs 
X@ = Output (AV) or USB device (USB)	 Number: 0000 or <output number> (0000 = untie input) 
	 Name: <name> 
	 IP address: <xxx.xxx.xxx.xxx> 
X# = Encoder (input) or decoder (output)	 Only first letter (i or o) is valid.X* = Total number of outputs 
X2! = Network interface	 1 = OOB LAN interface	 2 = NAV LAN interface 
X2@ = Subnet prefix	 Number of bits used to create the subnet 
X2# = Status	 0 = Off, disabled, not detected	 1 = On, enabled, detected 
X2$ = IP address, subnet, or gateway address	 xxx.xxx.xxx.xxx 
X2% = MAC address	 00-05-A6-xx-xx-xx  
X2^ = Endpoint inventory	 0 = No device or unassigned	 1 = Device online	 2 = Device offline 
X2& = USB device 
X2* = USB host
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NAVigator to Endpoints Communication (Encapsulation)
SIS commands cannot be issued directly to endpoints, but are issued via a NAVigator on 
the system network using encapsulation.

Encapsulation consists of placing a "{" delimiter, an X` variable, and a ":" separator before 
an SIS command that is to be issued to an endpoint (see the examples below). The X` 
variable serves as an identifier of the targeted endpoint. All encapsulated commands end 
with a "}" deliminator and a carriage return (CR = }).

The response from the endpoint also includes the identifier, enclosed in "{" and "}" 
delimiters.

NOTES:

•	 Encapsulated SIS commands must be valid for the endpoint (see the user guide for 
the applicable endpoint, available at www.extron.com, for a list of valid endpoint 
SIS commands). They do not need to be valid commands for the NAVigator.

•	 Just as in SIS commands to the NAVigator, | (pipe) and W can be used 
interchangeably with the } and E characters in encapsulated commands.

•	 You must issue an end delimiter and CR (" }} ") before you can start a new 
command. If you make a mistake entering the command, issue the end delimiter to 
start over.

Command Function Encapsulated Command 
(Host to Endpoint, via NAVigator)

Response 
(Endpoint to Host, via NAVigator)

Description
Encapsulation example:

 
Delimiter Seperator

Delimiter
CR

Identifier

{X`:<SIS command>}}

 
Delimiter Seperator

Identifier

{X`}<Response>

Encapsulated command to an encoder
Send a command to an encoder {X3!:<command>}} {X3!}X3@

Example: Mute video only 
command, using the input number

{0306I:1B}} {0306i}Vmt1]

Example: Mute video only 
command, using the encoder 
name

{NAV-E-101-17-84-05:1B}} {NAV-E-101-17-84-05}Vmt1]

Example: Mute video only 
command, using the endpoint IP 
address

{192.168.1.10:1B}} {192.168.001.010}Vmt1]

Encapsulated command to a decoder
Send a command to a decoder {X3#:<command>}} {X3#}X3@

Example: Read device name 
command, using the output number

{1217O:ECN}}} {1217o}<decoder name>]

Example: Read device name 
command, using the decoder name

{NAV-SD-101-17-84-C0:ECN}}} {NAV-SD-101-17-84-C0}<decoder name>]

Example: Read device name 
command, using the endpoint IP 
address

{192.168.1.3:ECN}}} {192.168.001.003}<decoder name>]

KEY:	 X3! = Input	 Number: <input number> I 
	 Name: <name> 
	 IP address: <xxx.xxx.xxx.xxx> 
X3@ = Response	 Valid response from the endpoint, including CRLF (]) (see the endpoint user guide) 
X3# = Output	 Number: <output number> O 
	 Name: <name> 
	 IP address: <xxx.xxx.xxx.xxx>

NOTE:	 Numeric X3!s and X3#s requires the of the I or O character because an input and output can have the same number. 
See Configure Selected Endpoint Communication Settings on page 27 to edit input and output numbers and IP addresses. 
See Add and edit names, tags, and locations. on page 33 to edit input and output names.
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Troubleshooting

Alarms
The following table lists common NAV alarms shown on the Monitoring page (see Alarms 
pane on page 91) and suggested remedies:

Alarm Cause Remedy

Assignment Conflict The NAVigator and endpoint report 
conflicting assignment statuses.

Perform a mode 5 reset on the endpoint 
that is causing the issue and then 
reassign it to the NAVigator.

Assignment Failure The NAVigator failed to assign a 
discovered endpoint.

Confirm that the NAVigator has not 
reached its endpoint assignment limit. 
If a device has been decomissioned 
from the NAV system, unassign the 
endpoint from the "Offline endpoints" 
list. If endpoint still cannot be assigned, 
perform a mode 5 reset on the endpoint.

Audio Loss The input audio signal level is below 
-60dB for a period of five minutes or 
more.

Increase the output level of audio 
source.

Auth Failures A user has attempted to login 
unsuccessfully 10 or more times.

Check whether login attempts were from 
internal personnel. If not take action to 
strengthen security measures.

Backup Restore Failure A problem occurred while trying to 
perform a backup or a restore.

Debug network connectivity between the 
NAVigator and endpoints.

Channel Conflict Two or more NAV devices on the 
network have been given the same input 
or output number.

For devices affected, change the input 
number or output number so that each 
is unique in the system.

Communication Failure An online assigned endpoint cannot 
establish a connection with the 
NAVigator.

Check the network settings to ensure 
unicast routing is possible between the 
NAVigator and endpoints.

Controller Disconnect The NAV device is unable to connect to 
a paired control processor.

Verify the control processor is online. 
Review network settings to ensure 
unicast communication is possible from 
the NAV device to the control processor.

CPU Usage The NAVigator CPU is overloaded. Check for excessive controller-to-
NAVigator communications.

Device Offline An assigned endpoint has gone offline, 
either due to power or a network 
connectivity loss.

Check the offline endpoint for a power 
failure. Check the network connectivity 
of the endpoint.

Disk Space Internal storage on the NAV device is 
low.

Reboot the NAV device. If the issue 
persists, perform a software reset 
that delete files (see Resetting the 
NAVigator on page 76).
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Alarm Cause Remedy

Firmware Failure A critical process has failed, crashing 
either the NAVigator or an endpoint.

Reboot the NAVigator. If the failure 
persists, perform a mode 1 reset.

Firmware Incompatible A firmware version discrepancy exists 
between the NAVigator and assigned 
endpoints.

Upgrade the firmware on the deviating 
device.

Firmware Upgrade The firmware upgrade process on 
NAVigator or endpoints failed to 
complete.

Retry the firmware upgrade. If it is again 
unsuccessful, use Toolbelt or a web 
browser to directly manage the device 
and perform a unit firmware upgrade.

HDCP Error Encoder: The video input signal is 
HDCP protected and HDCP negotiation 
has failed.

Decoder: The incoming stream is HDCP 
protected and the display connected to 
the output does not support HDCP or 
the HDCP version.

Encoder:

•	 Disconnect and reconnect the 
video input cable into the encoder 
(see the applicable NAV encoder 
user guide at www.extron.com).

•	 Bypass video adapter cables and 
make a direct HDMI male-to-male 
connection.

Decoder: Check the technical 
specifications of the display that is 
connected to the decoder for HDCP 
version support.

IGMP Failure The NAVigator failed to receive three 
consecutive IGMP queries from an IGMP 
querier.

Debug network connectivity between the 
NAVigator and the IGMP querier (which 
can be either a router or a managed 
switch).

Link Speed The negotiated communication speed 
(Link Speed) between the NAVigator 
and a managed switch is lower than its 
capability of 1 Gbps.

Check switch configuration and ensure 
proper settings for the switch port to 
which the NAVigator is connected.

Name Conflict Two or more NAV devices on 
the network have the same device name.

Change the device names affected so 
that each is unique.

Network Conflict Two or more NAV devices on  the 
network have the same IP address.

Change the IP addresses affected so 
that each is unique.

Network Utilization The NAVigator is receiving excessive 
network traffic.

Check the network for flooding, 
also check for improper network 
configuration.

NTP Sync The NAVigator cannot obtain time from 
the specified NTP Server

Debug the network connectivity between  
the NAVigator and the specified NTP 
server.

PTP Master Stability The clock to which all devices are 
synchronized is changing too frequently, 
for example, due to network jitter.

Check network for flooding and correct 
PTPv2 packet priority.

PTP Sync NAV device cannot synchronize its 
PTPv2 clock with any peers.

Ensure that network policies allow 
PTPv2 packets to reach the NAV Device 
from a clock master.

Stream Conflict Multiple NAV endpoints are configured 
to use the same video, audio, AES67, or 
USB multicast IP address.

Reconfigure endpoint stream settings for 
a unique stream address.

http://www.extron.com
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Alarm Cause Remedy

Stream error The decoder has lost reception of the 
stream for two or more seconds.

Check all network switches and routers 
that support your NAV system for proper 
multicast (IGMP) configuration.

Temperature Internal The NAVigator is overheating. Check the ambient temperature of 
NAVigator installation location.

•	 If greater than 140 °F, (60 ºC) use 
HVAC system to lower ambient 
temperature.

•	 If ambient temperature is 
140 °F, (60 °C) or less, check 
the mounting location for nearby 
equipment emitting excessive heat. 
Ensure there is an air gap around 
NAVigator to allow adequate airflow.

Tie Failure The NAVigator failed to establish a tie 
between the specified endpoints.

Debug the network connectivity between 
the NAVigator and endpoints.

Video loss The input is changed and video sync 
cannot be established for within a two-
second window.

Debug the connectivity of the A/V source 
device to the NAV encoder.
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Reference 
Information

This section provides additional reference information for the following NAVigator System 
Manager topics:

•	 Mounting the NAVigator

•	 Download a Firmware or Software Package

•	 Operation with AES67 Audio

Mounting the NAVigator

ATTENTION:

•	 Installation and service must be performed by authorized personnel only.

•	 L’installation et l’entretien doivent être effectués par le personnel autorisé uniquement.

The 1-inch high, quarter rack width NAVigator can be placed on a table, mounted in a rack, 
or mounted under a desk or table.

Tabletop Use
Affix the included rubber feet to the bottom of the unit and place it in any convenient 
location.

Mounting kits
Mount the unit using any optional compatible mounting kit listed on the Extron website, in 
accordance with the directions included with the kit.

ATTENTION:

•	 When mounting the NAVigator under furniture, mount the device upside-down to 
ensure proper ventilation.

•	 Si vous installez le NAVigator sous un mobilier, veillez à installer l’unité à l’envers 
pour assurer une bonne ventilation.

For rack mounting, see “UL Rack-Mounting Guidelines,” below.

UL Rack-Mounting Guidelines
The following Underwriters Laboratories (UL) requirements pertain to the installation of the 
unit into a rack.

•	 Elevated operating ambient temperature — If installed in a closed or multi-unit rack 
assembly, the operating ambient temperature of the rack environment may be greater 
than room ambient. Therefore, consider installing the equipment in an environment 
compatible with the maximum ambient temperature (TMA = +122 °F, +50 °C) specified 
by Extron.

http://www.extron.com
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•	 Reduced air flow — Installation of the equipment in a rack should be such that the 
amount of air flow required for safe operation of the equipment is not compromised.

•	 Mechanical loading — Mounting of the equipment in the rack should be such that a 
hazardous condition is not achieved due to uneven mechanical loading.

•	 Circuit overloading — Consideration should be given to the connection of the 
equipment to the supply circuit and the effect that overloading of the circuits might have 
on overcurrent protection and supply wiring. Appropriate consideration of equipment 
nameplate ratings should be used when addressing this concern.

•	 Reliable earthing (grounding) — Reliable earthing of rack-mounted equipment 
should be maintained. Particular attention should be given to supply connections other 
than direct connections to the branch circuit (such as use of power strips).

Download a Firmware or Software Package
Download a firmware or software package as follows:

NOTE:	 This procedure is used to download:

•	 Software such as Toolbelt, Global Configurator Pro, and Global Scripter

•	 NAVigator firmware updates

1.	 Go to www.extron.com and momentarily rest the cursor over the Download tab 
(see figure 118, 1). The Find Software & Downloads links appear.

11111111111111
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Figure 118.	 Selecting the Download Tab

2.	 Click the Firmware or Software link (2). The main download page opens 
(see figure 119 on page 124).

http://www.extron.com
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NOTE: The file name, part number, version, release 
date, and size shown are sample values only.

Figure 119.	 Downloading from the Main Download Page
  

3.	 Click the desired filtering letter (see figure 119, 1) to jump to the nearest page of 
downloads.

4.	 Click Download for the desired software or firmware package to download (2). The Log 
in dialog box appears (see figure 120).
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Figure 120.	 Log in Dialog Box

5.	 Enter the E-Mail address and Password associated with your Extron insider account 
(see figure 120, 1).
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TIPS:

•	 Click Sign up (see figure 120, A on page 119) to obtain website credentials.

•	 Click Keep me logged in (B) to eliminate steps 5 and 6 in future downloads.

•	 Enter your registered email address (C) and click Retrieve Password (D) if 
you have forgotten your credentials.

6.	 Click Log in to copy the package to the computer (2).

7.	 If your browser asks you to confirm that you want to continue, click Run or make a 
similar confirmation that you want to run the installation (see figure 121, 1).

111111111111111111

Figure 121.	 Download Warning and Confirmation

NOTES:	

•	 Figure 121 may look different or may not appear at all, depending on your web 
browser choice and its security settings.

•	 File names and version numbers on this page are sample values only.

8.	 Return to either Control System on page 108, Upgrading the NAVigator firmware 
on page 74, or Upgrading the system firmware on page 83.
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Operation with AES67 Audio
You can tie an Extron AES67-capable device, such as a DMP 128 ProDSP Digital Matrix 
Processor, into the NAV system. See the user guide for the applicable device to configure 
that device and also the Dante documentation. Once you have configured the AES67 device, 
the device is displayed on the NAVigator HTML Ties page. If you have AES67 selected as 
the audio plane and AES67 addresses applied (see Configure the streaming settings, 
steps 3 and 4 on page 44) you can make ties as described in Create Ties on page 29.

Figure 123 shows three AES67-enabled DMP streams displayed on the Ties page. AES67 
audio from the processors is tied to three separate NAV decoders (1).
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Figure 122.	 Ties Page with AES67-Enabled DMP Processors



Extron Warranty

Extron warrants this product against defects in materials and workmanship for a period of three years from the date 
of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/
or materials, Extron will, at its option, repair or replace said products or components, to whatever extent it shall 
deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty 
period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America:
Extron 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

Asia:
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Japan:
Extron Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe:
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China:
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Middle East:
Extron Middle East 
Dubai Airport Free Zone 
F13, PO Box 293666 
United Arab Emirates, Dubai

Africa:
Extron South Africa 
3rd Floor, South Tower  
160 Jan Smuts Avenue  
Rosebank 2196, South Africa

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA:	 714.491.1500 or 800.633.9876	 Asia:	 65.6383.4400	  

	 Europe:	31.33.453.4040 or 800.3987.6673	 Japan:	 81.3.3511.7655
	 Africa:	 27.11.447.6162	 Middle East:	 971.4.299.1800	  

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron be liable for direct, indirect, or 
consequential damages resulting from any defect in this product even if Extron has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.

Worldwide Headquarters:  Extron USA West, 1025 E. Ball Road, Anaheim, CA 92805, 800.633.9876

Contact Information
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